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Introduction
Your EPSON Stylus® COLOR 900 printer is the ideal output device for
business graphics, digital photographs, newsletters, and more. With
resolutions up to 1440 by 720 dpi and EPSON’s unique variable micro
droplet technology, you get amazingly realistic photographic images, vivid
color graphics, and sharp black text—all at unprecedented speeds.
The printer software for Microsoft® Windows® and Apple® Macintosh®
provides advanced color management with adjustable levels of
brightness, contrast, sharpness, and other settings. You get even more
precise color matching with ColorSync™ 2.01 and two Windows color
management systems.
EPSON’s specially formulated ink cartridges and wide variety of ink jet
papers offer the most flexibility for getting the results you want. With
standard parallel, serial, and high-speed USB (Universal Serial Bus)
ports, setting up your printer is fast and easy.
This chapter gives general printer information in these sections:
◗ Windows System Requirements
◗ Macintosh System Requirements
◗ How To Use Your Manuals
◗ ENERGY STAR Compliance
◗ Year 2000 Ready
◗ Important Safety Instructions

Introduction
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Windows System Requirements
To use your printer and its software with a PC, your system should have:
◗ An IBM®-compatible PC with at least a 386/25 MHz (for
Windows 3.1x), 486/25 MHz (for Windows 95 or Windows NT® 4.0),
or 486/66 MHz (for Windows 98) processor
◗ DOS, Windows 3.1x, Windows 95, Windows 98, or Windows NT 4.0
◗ At least 16MB of RAM (32MB for Windows 3.1, 95, or 98 or 64MB for
Windows NT 4.0 recommended)
◗ At least 50MB of free hard disk space for storing images (100MB
recommended)
◗ VGA, Super VGA, or better display adapter and monitor
◗ Double-speed (2X) CD-ROM drive (quad-speed [4X] or faster
recommended) for installing the printer software
◗ For parallel connection, a high-speed, bidirectional, IEEE-1284
compliant parallel cable (6 to 10 feet long); the cable must have a
D-SUB, 25-pin, male connector for your computer and a 36-pin,
Centronics® compatible connector for the printer.
Using an improperly
shielded USB cable—
especially a cable
more than 6.5 feet
(2.0 meters) long—
may cause the printer
to malfunction.

Introduction

For USB connection to a computer running Windows 98 with a
Windows 98 compliant USB port, a shielded USB “AB” interface cable,
from Series A (computer) to Series B (printer), up to 6.5 feet
(2.0 meters) long.
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Macintosh System Requirements

Using an improperly
shielded USB cable—
especially a cable
more than 6.5 feet
(2.0 meters) long—
may cause the printer
to malfunction.

Introduction

To use your printer and its software with a Macintosh, your system should
have:
◗ One of the following Macintosh models:
LC475, LC575, LC630
Quadra series
Centris series
PowerBook® series (190, 520, 540, 550, or later)
PowerBook Duo 280, 2300c/100
Performa® 475, 575, 588, 630, 5210 or later
Power Macintosh® series
iMac™ series (for USB connection only)
◗ For serial connection: System 7.5.1 or later (7.6 or later
recommended)
For USB connection: iMac with System 8.1 or later
◗ At least 16MB of available RAM (32MB recommended)
◗ At least 50MB of free hard disk space (100MB recommended)
◗ RGB display or better
◗ Double-speed (2X) CD-ROM drive (quad-speed [4X] or faster
recommended) for installing the printer software
◗ For serial connection: an ImageWriter ® II serial cable or equivalent
(8-pin mini DIN male/male, Belkin brand recommended; EPSON part
number: F2V024-06)
For USB connection to an iMac computer: a shielded USB “AB”
interface cable, from Series A (computer) to Series B (printer), up to
6.5 feet (2.0 meters) long.
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How To Use Your Manuals
To set up your printer and install the printer software, see the Start Here
card. This manual contains the following information:
Basic Printing covers the basics of printing with Windows or Macintosh.
Advanced Printing tells you how to print using custom settings for print
quality, color management, and distinctive layouts.
Printing on Special Media gives guidelines for selecting the right paper or
other media for your print job and instructions for loading it in your printer.
Managing Print Jobs explains how to control print jobs and check printer
status while you’re printing.
Network Printing describes how to set up your computers so you can use
your printer on a network.
Optional Interfaces gives instructions on how to install and use EPSON
interface boards.
Maintenance and Transportation gives instructions for replacing ink
cartridges, cleaning and aligning the print head, and cleaning and
transporting the printer.
Troubleshooting provides solutions for any problems you may have with
your printer or software.
Specifications provides the technical details on your printer, ink
cartridges, and EPSON papers.
To go right to the section you need, see the Index.

Introduction
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Using Links
Green, underlined text indicates that the text is a link (cross-reference) to
other parts of this manual. Click on the text with the mouse pointer to view
the referenced information.

Warnings, Cautions, Notes, and Tips
You’ll find this information throughout your manual:
Warnings must be followed carefully to avoid bodily
injury.

Cautions must be observed to avoid damage to your
equipment.

Notes contain important information about your printer.

Tips contain additional hints for better printing.

Introduction
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ENERGY STAR Compliance
As an ENERGY STAR Partner, EPSON has determined that this product
meets the ENERGY STAR guidelines for energy efficiency.
The EPA ENERGY STAR Office Equipment program is a voluntary
partnership with the computer and office equipment industry to promote
the introduction of energy-efficient personal computers, monitors,
printers, fax machines, and copiers in an effort to reduce air pollution
caused by power generation.

Year 2000 Ready
Your EPSON printer is Year 2000 Ready. However, be sure the other
parts of your computer system are also ready for the year 2000.

Important Safety Instructions
Before using your printer, read the following safety instructions to make
sure you use the printer safely and effectively:
Always turn the
printer off using the
P power button.
Don’t switch off the
power strip, or unplug
the printer until the
P power light is off.

Introduction

◗ Turn off and unplug the printer before cleaning. Clean with a damp
cloth only. Do not spill liquid on the printer.
◗ Do not place the printer on an unstable surface or near a radiator,
heating vent, or direct sunlight.
◗ Do not block or cover the openings in the printer’s case or insert
objects through the slots.
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◗ Use only the type of power source indicated on the printer’s label.
◗ Connect all equipment to properly grounded power outlets. Avoid
using outlets on the same circuit as photocopiers or air control systems
that regularly switch on and off.
◗ Place the printer near a wall outlet where the plug can be easily
unplugged.

Placez l’imprimante près d’une prise de contacte où la fiche peut être
débranchée facilement.
◗ Do not let the power cord become damaged or frayed.
◗ If you use an extension cord with the printer, make sure the total
ampere rating of the devices plugged into the extension cord does not
exceed the cord’s ampere rating. Also, make sure the total ampere
rating of all devices plugged into the wall outlet does not exceed the
wall outlet’s ampere rating.
◗ Except as specifically explained in this manual, do not attempt to
service the printer yourself.
◗ Unplug the printer and refer servicing to qualified service personnel
under the following conditions:
If the power cord or plug is damaged; if liquid has entered the printer;
if the printer has been dropped or the case damaged; if the printer
does not operate normally or exhibits a distinct change in performance.
Adjust only those controls that are covered by the operating
instructions.
◗ Do not put your hand inside the printer or touch the cartridge during
printing.

Introduction
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◗ Under normal circumstances, ink will not come out of the cartridge. If it
does get on your skin, wash it off with soap and water. If it gets in your
eyes, flush them immediately with water.
◗ Keep ink cartridges out of the reach of children.
◗ Do not dismantle the ink cartridges or try to refill them. This could
result in damage to the print head.
◗ Once you install an ink cartridge, do not open the clamp or remove the
cartridge except to replace it with a new one. The cartridge may
become unusable otherwise.
◗ Install the ink cartridge immediately after you remove it from its foil
package. Leaving the cartridge unpacked for a long time before use
may result in reduced print quality.
◗ Do not use an ink cartridge beyond the date printed on the cartridge
package. For best results, use up the ink cartridges within six months
of installing them.
◗ Do not shake an ink cartridge; this can cause leakage.
◗ Always turn the printer off using the P power button. When you press
this button, the P power light flashes briefly then goes out. Do not
unplug the printer or turn off the power to the printer until the P power
light is off.
◗ Before transporting the printer, make sure the print head is capped in
the far right position and the ink cartridges are in place.

Introduction
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Basic Printing
It’s easy to print all your documents with your EPSON Stylus COLOR
900. First set up your printer and install the software, following the
instructions in the Start Here card. Read this chapter to find out about:
For instructions on
printing with DOS,
see “Using Your
Printer with DOS” in
the Printer Basics
book.

◗ Printing from Windows
◗ Printing from a Macintosh

Printing from Windows
This section tells you about:
◗ Printing from Windows Applications
◗ Setting Default Printer Options
◗ Checking Printer Status

Basic Printing
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Printing from Windows Applications

Most Windows
examples show
screen captures for
Windows 95.
Differences from
Windows 3.1 or
Windows NT are
noted in the text or
with another screen
capture.

Basic Printing

This section describes the settings you’ll need to check for all your
everyday printouts. See Advanced Printing for information about
advanced settings for special print jobs.
1 Open a Windows application and select a file you want to print.
2 Open the File menu and click Print. You see the Print dialog box for
your application (the Print dialog box for your application may look
slightly different):

Click Properties

Page 18
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3 Make sure your EPSON Stylus COLOR 900 printer is selected, and
then click the Properties button. (If you see a Setup, Printer, or
Options button, click it instead. Then click Properties on the next
screen.)
In Windows 95, 98,
and NT, you can
right-click on an
option for more
information.

You then see the printer settings dialog box:

Click to select your
Media Type
Click to select
Automatic mode

You can also set
printer options by
clicking Print Setup in
the File menu, then
clicking the Printer,
Setup, Properties, or
Options button.
However, in most
applications you’ll
then have to select
the Print option from
the File menu to print
using your changes.

Basic Printing

Use the
Quality/Speed
slider to select your
print resolution

Click for more
information
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4 Click the Main tab if necessary. Then choose the Media Type you want
to print on from the following list:
◗ Plain paper
◗ 360 dpi Ink Jet Paper
To print at the highest
resolution (1440 dpi),
you need to use plain
paper, Photo Paper,
or one of the Photo
Quality media. For the
best printing at any
resolution, always use
EPSON media.

◗ Photo Quality Ink Jet Paper
◗ Photo Paper
◗ Photo Quality Glossy Film
◗ Ink Jet Transparencies
The type of paper you choose determines the print quality (resolution)
you can use. It’s very important to select the correct setting for your
paper. If you’re not sure which to choose, see Selecting Special Media.
5 Choose Color or Black ink.
6 Now make sure the Mode option is set to Automatic. This is the
easiest way to get good printing results for all kinds of documents, on
all types of paper.
7 Set the slider to Quality or Speed. Some Media Types also have an
intermediate setting. This lets you choose from the fastest printing,
high quality printing, or an intermediate setting (if available) that
balances quality with speed for the media you’re using.

The Quality/Speed
slider is not available
for certain media
types.

Basic Printing

To select 1440 dpi on plain paper or any other available resolution for
your media, you need to access the Advanced dialog box; see
Customizing Print Quality and Special Effects for instructions.
8 Click the Paper tab and choose your Paper Size, number of Copies,
Orientation, and Printable Area settings; see Selecting Paper Options
in Windows for instructions.
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9 Click the Layout tab (not available with Windows 3.1) and check the
Reduce/Enlarge, Print Layout, and Watermark settings. See Choosing
Print Layout Options in Windows for details.
10 Click OK when you’re finished checking your settings. The dialog box
closes. Click OK until you see the Print dialog box.
11 In the Print dialog box, click OK or Print.
While your document is printing, a window appears showing the printer
status and the progress of your print job. See Checking Printer Status
for more information.

Setting Default Printer Options
When you change printer settings through your software application, the
settings apply only to the application you’re using. To adjust the default
settings for all your Windows applications, access the printer settings
through the Printers utility or Control Panel (Windows 3.1). Close all your
applications before you start. If you don’t, you may have to close and
reopen them to use the new default settings.
See the section for your operating system:
◗ Setting Default Options in Windows 95, Windows 98, or Windows NT
◗ Setting Default Options in Windows 3.1

Basic Printing
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Setting Default Options in Windows 95, Windows 98, or
Windows NT
1 Click Start, point to Settings, and select Printers.
You can access the
default Windows NT
printer software
settings only if you
have the appropriate
network access
privileges, such as
Administrator.

2 Right-click the EPSON Stylus COLOR 900 icon.
3 Select Properties or Document Defaults (Windows NT), then click
the Main tab. You see the following dialog box:
These tabs are available only when the
dialog box is accessed from the Start menu

Click to select
your Media Type
Click to select
Automatic mode

Use the
Quality/Speed
slider to select your
print resolution

Click for more
information

4 Change the printer software settings, as necessary. Then click OK to
apply your new default settings.

Basic Printing
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Setting Default Options in Windows 3.1
1 Double-click the Control Panel icon in the Main group.
2 Double-click the Printers icon.
3 Select EPSON Stylus COLOR 900 from the list of installed printers
and click Setup. You see the following printer settings dialog box:

Click to select
Automatic mode
Click to select
your Media Type

Use the
Quality/Speed slider
to select your print
resolution

Click for more
information

4 Change the printer software settings, as necessary. Then click OK to
apply your new default settings.

Checking Printer Status
While your document is printing, your printer software reports how the job
is doing. See the section for your operating system:
◗ Windows 95, Windows 98, or Windows NT 4.0
◗ Windows 3.1

Basic Printing
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Windows 95, Windows 98, or Windows NT 4.0
After you send a print job, the Progress Meter window appears on your
screen:
Click to cancel
Click to pause
Click to restart
This information
appears only if you
installed Status
Monitor 2

Click to view the
Status Monitor 2
Printer Status window

The Progress Meter shows the progress of your print job and the status of
your printer. You can use the buttons to cancel, pause, or restart your
print job.
If you installed Status Monitor 2, you also see information about how
much ink you have left and can view the Status Monitor 2 Printer Status
window. See Using Status Monitor 2 for more information.
You can also set up the way your printer software sends print jobs and
select whether or not to display the Progress Meter. See Optimizing Data
Transfer and Displaying the Progress Meter for instructions.

Basic Printing
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Windows 3.1
After you send your print job, the EPSON Despooler dialog box appears
on your screen:

Click to pause or
resume printing
Click to cancel printing

Click to restart
printing

This dialog box shows the progress of your print job and the status of your
printer. If you run out of paper while printing, for example, the Despooler
warns you. You can use the buttons to cancel, pause, or restart your print
job.
You can also control print jobs using the Spool Manager; see Using the
Spool Manager for more information.

Basic Printing
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Printing from a Macintosh
On the Macintosh,
printer settings are
saved with your
document, but not
from one application
to another. If you
want to reuse
settings, you can
create document
templates for your
favorite applications.
You can also create
custom setting groups
in your printer
software that you can
select each time you
open an application.
See Saving Custom
Settings for details.

Basic Printing

When you print with a Macintosh, you need to check the printer software
settings in each application you use. This section describes the settings
you’ll need to check for all your everyday printouts. See Advanced
Printing for information about advanced settings for special print jobs.
Follow these steps to print from a Macintosh:
1 Open a Macintosh application and select a file you want to print.
2 Open the File menu and click Page Setup (Document Setup in some
applications). You see the Page Setup dialog box:

3 Choose your paper size, orientation, and other options as described in
Selecting Paper Options on a Macintosh and click OK.
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4 Now open the File menu and click Print. You see the main printer
settings dialog box:

Click to select your
Media Type
Click to select
Automatic mode

Use the Quality/Speed slider to select your print resolution

5 Choose the number of copies and indicate which pages you want to
print.
6 Choose the Media Type you want to print on from the following list:
For printing at the
highest resolution
(1440 dpi), you need
to use plain paper,
Photo Paper or one of
the Photo Quality
media. For the best
printing at any
resolution, always use
EPSON media.

◗ Plain Paper
◗ 360 dpi Ink Jet Paper
◗ Photo Quality Ink Jet Paper
◗ Photo Paper
◗ Photo Quality Glossy Film
◗ Ink Jet Transparencies
The type of paper you choose determines the print quality (resolution)
you can use. It’s very important to select the correct setting for your
paper. If you’re not sure which to choose, see Selecting Special Media.
7 Choose Color or Black ink.

Basic Printing
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8 Make sure the Mode option is set to Automatic. This is the easiest
way to get good printing results for all kinds of documents, on all types
of paper.

The Quality/Speed
slider is not available
for certain media
types.

9 Set the slider to Quality or Speed. Some Media Types also have an
intermediate setting. This lets you choose from the fastest printing,
high quality printing, or an intermediate setting (if available) that
balances quality with speed for the media you’re using. To select
1440 dpi on plain paper or any other available resolution for your
media, you need to access the Advanced dialog box; see Customizing
Print Quality and Special Effects for instructions.
10 Click the
Layout icon and check the Fit to Page, Watermark, Print
Layout, and Print Order settings. See Choosing Print Layout Options
on a Macintosh and Selecting Print Order Options for details. Then
click OK to return to the printer settings dialog box.
11 Background printing allows you to continue working while your
document prints. To select background printing options before you
print, click the
Background Printing icon. See Setting Up
Background Printing Options for details.
12 If you want to preview your printout to view how the current layout,
watermark, print order, and orientation settings look, click the
Preview icon, then click the Preview button. See Using Print
Preview on the Macintosh for details.
13 Click Print when you’re finished checking your settings.
If you’ve turned on background printing, you can continue working while
your document is printing. While printing, a window appears showing the
printer status and the progress of your print job. See Using Monitor3 for
details.

Basic Printing
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Checking Printer Status
If you turned on background printing, EPSON Monitor3 automatically
displays this dialog box when you send a print job to the printer:

Job currently
printing
Jobs waiting to
print

Click to set priorities
or print times for
waiting print jobs

When background
printing is turned off,
you can cancel your
print job by pressing
the J and . (period)
keys.

Basic Printing

You can use the Monitor3 dialog box to check on your print jobs and
cancel, pause, or restart them. The progress bar tracks the status of the
current print job. To cancel, pause, or restart a print job (either the current
one or any job waiting to print), click the document’s name to highlight it.
Then click one of the following buttons:
◗ click

to delete

◗ click

to restart

◗ click

to pause
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Advanced Printing
When your presentation graphics, photographs, or other projects have
special printing requirements, you can use the advanced settings in your
EPSON Stylus COLOR 900 software. You can choose custom project
types or adjust individual settings like brightness, contrast, sharpness,
and halftoning. For professional-quality color accuracy, you can use a
color management system.
Your printer software’s print layout options let you print almost any size
image on your printer, proof multiple pages on one sheet of paper, and
add watermarks (not available with Windows 3.1).
This chapter includes the following information:
◗ Using Custom Project Types
◗ Customizing Print Quality and Special Effects
◗ Customizing Color Settings
◗ Using ColorSync on the Macintosh
◗ Selecting Paper Size and Orientation Options
◗ Selecting Print Layout Options
◗ Using Print Preview on the Macintosh
◗ Saving Custom Settings

Advanced Printing

Page 30

color900.book Page 31 Wednesday, January 6, 1999 12:39 PM

Using Custom Project Types
Custom project types provide an easy way to fine-tune your printer
settings for a specific type of project. Follow these steps to print with
custom project types:
1 Create your image or document in your application software.
2 Access the printer settings dialog box as described in Printing from
Windows or Printing from a Macintosh. You see one of the following
dialog boxes:
Click Custom, then click here
to see a list of project types
Click Advanced, then click here
to see a list of project types
Click Custom, then click here
to see a list of project types

Windows 95, 98, NT

Advanced Printing

Windows 3.1

Macintosh
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3 Choose the Media Type you want to print on. (If you’re not sure which
setting to choose, see Selecting Special Media.)
4 Choose Color or Black ink.
Always choose your
Media Type and Ink
setting before you
select a custom
project type. Some
project types may not
be available with the
Media Type or Ink
settings you choose.
Printing with
PhotoEnhance3 or
PhotoEnhance may
take longer with some
systems and images.

5 Click Custom (in Windows 3.1, click Advanced), and then click
Custom Settings. You see the list of project types.
6 Choose the right setting for your project and Media Type following
these guidelines:
◗ PhotoEnhance3 (Windows 95, 98, NT, or Macintosh) or
PhotoEnhance™ (Windows 3.1)
For printing images captured using a video camera, scanner, or
digital camera. Produces sharper images and more vivid colors by
automatically adjusting the contrast, saturation, and brightness.
Corrects for overall under- and over-exposure of the original image.
◗ Digital Camera (not available with Windows 3.1)
For printing images captured using a scanner or digital camera.
Corrects noise and other common flaws.
◗ Text/Graph
For printing graphics-intensive documents like presentation pages
with charts and graphs. Intensifies colors and lightens the midtones
and highlights.
◗ Economy
For printing rough drafts of text on plain paper. Saves ink.
◗ ICM (Image Color Matching; Windows 95 and Windows 98 only)
For printing documents created in an ICM compatible application. If
you’re using an ICM compatible monitor, adjusts printed colors to
closely match the screen colors.
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◗ sRGB (Standard Red Green Blue; not available with Windows 3.1;
recommended only with Windows 98)
For printing documents created in an sRGB compatible application
using sRGB colors, such as those designed for the World Wide
Web. First set up your sRGB compatible devices (such as your
monitor and printer) to use an sRGB color profile; see your
Windows 98 online help for details.
◗ ColorSync (Macintosh only)
Automatically adjusts printout colors to closely match the colors on
your screen. For more information, see Using ColorSync on the
Macintosh.
7 In Windows, click the Paper and Layout tabs (not available on
Windows 3.1) to check or change any necessary settings, as
described in Selecting Paper Options in Windows and Choosing Print
Layout Options in Windows.
On a Macintosh, check or change any necessary settings on the Page
Setup and the Layout dialog boxes as described in Selecting Paper
Options on a Macintosh and Choosing Print Layout Options on a
Macintosh.
8 When you’re finished, click OK (Windows) or Print (Macintosh). If
you’re using Windows, click any other buttons that your application
uses for printing.
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Customizing Print Quality and Special Effects
After you customize
your print settings for
a special project, you
can save them as a
group. Then you can
reuse them whenever
you print a similar
project. See Saving
Custom Settings for
instructions.

If you selected a
Custom Project type,
the Color Management
section may look
different. Clicking
Color Adjustment to
get this view also
changes your Custom
Project type.
Advanced Printing

If you need the maximum control over your project, or you want to
experiment with special effects, you can adjust the custom settings in
your printer software. Follow these steps:
1 Create your image or document in your application software.
2 Access the printer settings dialog box as described in Printing from
Windows or Printing from a Macintosh.
3 Click Custom, and then click the Advanced button. (In Windows 3.1,
click Advanced, then click the More Settings button.) You see the
Advanced dialog box (called More Settings in Windows 3.1):
Click here to change your
Print Quality (resolution)

Windows 95, 98, NT

Windows 3.1

Some of these options are automatically set
or disabled by other settings you choose

Page 34

color900.book Page 35 Wednesday, January 6, 1999 12:39 PM

Click here to change your Print
Quality (resolution)
Some of these options are
automatically set or disabled
by other settings you choose
Macintosh

4 Choose the Media Type and Ink settings you want to use, following
the guidelines in Printing from Windows and Printing from a Macintosh.
5 Choose one of the following Print Quality options:
◗ Economy
For low-resolution rough drafts on plain paper. Saves ink.
The available Print
Quality settings may
be limited by the
Media Type you
choose.

◗ Normal - 360 dpi
For most documents on plain paper, transparencies, or 360 dpi Ink
Jet Paper.
◗ Fine - 360 dpi
For high speed, high quality output.
◗ Photo - 720 dpi
Excellent high-resolution output.
◗ Photo - 1440 dpi
For the highest-resolution output.
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6 Choose one of the following Halftoning options:
◗ No Halftoning
Select when printing black text only.
In Automatic mode,
the Halftoning setting
is selected based on
the data in your print
job. In Custom mode,
Halftoning is
preselected for each
project type setting.
Some of the print
options at the bottom
left of the Advanced
dialog box are
automatically
selected or disabled
by the Print Quality
(resolution) you
choose.

◗ Error Diffusion
For printing photographic images. Blends each color dot with the
dots around it.
◗ Fine Dithering
For printing graphs or other images that require precise, solid areas
of bright colors.
7 Choose any of the following print options:
◗ MicroWeave
This option is automatically selected or disabled by the Print Quality
you choose and is not user selectable. MicroWeave prints graphic
data in finer increments to eliminate unwanted banding (light
horizontal lines).
◗ High Speed
For fast, bidirectional printing at lower quality. If vertical lines in your
printout are misaligned when you use the High Speed setting, you
may need to turn it off or align the print head; see Aligning the Print
Head for instructions.
◗ Flip Horizontal
For printing a mirror image of your document. Use with iron-on
transfer paper so your ironed-on printout will read correctly.
◗ Finest Detail
For printing text, graphics, and line art with very sharp edges. Slows
print speed and increases your system memory requirements.
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8 Click OK if you’re ready to return to the printer settings dialog box, or
see Customizing Color Settings if you want to adjust your document’s
color settings.

Customizing Color Settings
There are three ways to manage the color in your documents using your
printer software:
◗ Using PhotoEnhance3 or Digital Camera Correction Mode to
automatically correct digital photographs for exposure and other
common flaws, and to adjust the tone or sharpness.
◗ Using Custom Color Management Modes to select individual color
values to fine-tune the color in text, graphics, or economy mode
documents.
◗ Using a Color Management System for maximum color accuracy.
The appearance of the Color Management section of the Advanced
dialog box changes, depending on the settings you’ve selected.
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Using PhotoEnhance3 or Digital Camera Correction
Mode
To correct the exposure, tone, and sharpness of digital images, you can
use PhotoEnhance3 and/or Digital Camera Correction mode. These
options are not available on Windows 3.1.
The Color
Management section
also changes to this
view if you select the
PhotoEnhance3
button on the
Advanced dialog box.

1 Create your image or document in your application software.
2 Access the printer settings dialog box as described in Printing from
Windows or Printing from a Macintosh.
3 Click Custom, then select either PhotoEnhance3 or Digital Camera
as described in Using Custom Project Types.
4 Click the Advanced button. The Color Management section of the
Advanced dialog box appears as shown here:

Click to select a Tone
setting, if necessary.
Changes appear in the
example photograph.
Click to turn on Digital
Camera Correction and/or
sharpen the image.
Macintosh

Advanced Printing
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5 You can customize your image using these settings:
◗ Select a Tone setting for your image: Normal for standard tones,
Hard for high contrast, or Sepia for an old-fashioned photo look.
◗ Turn on Digital Camera Correction to correct noise and other
flaws common to digital camera images.
◗ Select Sharpness to sharpen the image, especially the edges.
6 Click OK to return to the printer settings dialog box.

Using Custom Color Management Modes
You can choose from several custom Color Management modes or
manually adjust brightness, contrast, saturation, and CMY (cyan,
magenta, yellow) color values.
1 Create your image or document in your application software.
2 Access the printer settings dialog box as described in Printing from
Windows or Printing from a Macintosh.
3 Click Custom (in Windows 3.1, click Advanced), then select either
Text/Graph or Economy, or don’t select any custom project type. (For
a description of custom project types, see Using Custom Project
Types.)
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4 Click the Advanced button (More Settings in Windows 3.1). The Color
Management section of the Advanced dialog box appears as shown:

Click the Color
Adjustment button if
you don’t see this
view.
The appearance of
the Color section of
the More Settings
dialog box always
appears as shown
here on Windows 3.1.

Not available with
Windows 3.1;
ICM not available
with Windows NT

Windows

Macintosh

5 Choose one of the following Color Adjustment Modes:
◗ Automatic
Analyzes the color information in your project and optimizes color
correction accordingly.
◗ Photo-realistic
For printing color photographs.
◗ Vivid
For printing graphics-intensive documents like presentations with
charts and graphs. Intensifies colors and lightens the midtones and
highlights.
◗ No Color Adjustment
Disables the color adjustment features of the printer software so
you can use a stand-alone color management utility.
Advanced Printing
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6 If you want to specify individual color correction values, use the sliders
to increase (drag right) or decrease (drag left) the settings listed below:
◗ Brightness
Makes your image lighter or darker.
◗ Contrast
Increases or decreases the difference between the bright or dark
parts of an image.
◗ Saturation
Makes colors more vivid or less vivid.
◗ Cyan, Magenta, Yellow
Increases or decreases the amount of the three ink colors that
combine to make a full-color printout. Use these sliders to fine-tune
the color balance in your printout.
7 Click OK to return to the printer settings dialog box.
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Using a Color Management System

You can also select
Color Management
Systems on the
Advanced dialog box.

To achieve the maximum color accuracy, you can use Image Color
Matching (ICM; Windows 95 and 98 only), Standard Red Green Blue
(sRGB; Windows 95, 98, and NT only), or ColorSync (Macintosh only), if
your system is set up to use them.
1 Create your image or document in your application software.
2 Access the printer settings dialog box as described in Printing from
Windows or Printing from a Macintosh.
3 Click Custom.
4 In the Custom Settings box, select one of these custom project types
for color management systems:
◗ ICM (Windows 95 and Windows 98 only)
For printing documents created in an ICM compatible application. If
you’re using an ICM compatible monitor, adjusts printed colors to
closely match the screen colors.
◗ sRGB (Standard Red Green Blue; not available with Windows 3.1;
recommended only with Windows 98)
For printing documents created in an sRGB compatible application
using sRGB colors, such as those designed for the World Wide
Web. First set up your sRGB compatible devices (such as your
monitor and printer) to use an sRGB color profile; see your
Windows 98 online help for details.
◗ ColorSync (Macintosh only)
Automatically adjusts printout colors to match colors on the screen.
See Using ColorSync on the Macintosh for more information.

Advanced Printing

Page 42

color900.book Page 43 Wednesday, January 6, 1999 12:39 PM

Using ColorSync on the Macintosh
Every device you use for producing or viewing colors—your monitor,
scanner, and printer—employs a different color technology. The
Macintosh ColorSync system helps you control all your devices so their
colors match your printer’s as closely as possible.
ColorSync uses profile information from each device—including your
EPSON Stylus COLOR 900 printer—to achieve accurate color matching.
First you have to make sure your monitor’s profile is set. Then you can
use your printer software to specify the exact method of color matching
you want to use.
Follow these steps to set your monitor’s ColorSync profile and use your
printer software’s ColorSync features:
1 Open the ColorSync System Profile under Control Panels on the
Apple menu.
2 Click the Set Profile button.
3 Select your monitor from the list, and then click Select.
4 Close ColorSync System Profile.
5 Open an application and select a document to print.
6 Open the File menu and click Print.
7 Click Custom, then click Advanced.
8 On the Advanced dialog box, click the ColorSync button.
9 For Profile, choose EPSON Standard. This is the ColorSync profile
created especially for your printer. Don’t choose any other printer
profile you may have on your system.
Advanced Printing
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10 Choose one of the following options for Rendering Intent:

The Rendering Intent
options may be
limited by the Media
Type you’ve selected.

◗ Perceptual
For printing scanned photographs. Maintains the relationships
among colors as it scales them to fit within your printer’s color
gamut.
◗ Saturation
For printing graphics-intensive documents like presentation pages
with charts and graphs. Maintains the relative saturation of colors
from one gamut to another.
◗ Colorimetric
For all other document types. Maintains the colors that fall within the
gamut of both your monitor and printer.
11 Click OK to return to the printer settings dialog box.

Selecting Paper Size and Orientation Options
Your printer can print on paper up to 9.5 inches wide and up to 44 inches
long in either portrait or landscape orientation. If you print multi-page
documents or multiple copies of documents, you can print the pages
collated and in reverse order. You can even rotate the printed document
by 180 degrees (not available with Windows 3.1).
Follow the steps in the section for your operating system:
◗ Selecting Paper Options in Windows
◗ Selecting Paper Options on a Macintosh
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Selecting Paper Options in Windows
Follow these steps to select paper options on the Paper tab:
1 Create your image or document in your application software.
2 Access the printer settings dialog box as described in Printing from
Windows.
3 Click the Paper tab. You see the Paper dialog box:

Click to select
your Paper Size

Printer graphic
reflects changes
to Orientation
and Printable
Area settings

Advanced Printing

Page graphics
change to show
Collate and
Reverse Order
settings
Rotate by 180° is
not available with
Windows 3.1
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4 Click the Paper Size drop-down list to select the size of paper you
loaded in the printer.

If the Reduce/Enlarge
setting is set to
Normal and you
select one of the
paper sizes to the
right that is marked
with an asterisk (*),
you see a dialog box
asking you to select a
paper size that fits
your printer. See
Reducing and
Enlarging Your
Document Size for
more information.

The sizes marked with an asterisk (*; not available with Windows 3.1)
are larger than you can load in the printer and can be used only with
the Reduce/Enlarge setting on the Layout tab; see Reducing and
Enlarging Your Document Size for more information.
A4 210 × 297 mm
B5 182 × 257 mm
A5 148 × 210 mm
Letter 8 1/2 × 11 in
Legal 8 1/2 × 14 in
Executive 7 1/4 × 10 1/2 in
Half Letter 5 1/2 × 8 1/2 in
A6 Index card 105 × 148 mm
Index card 5 × 8 in
Index card 8 × 10 in
Envelope #10 4 1/8 × 9 1/2 in
Envelope DL 110 × 220 mm
Envelope C6 114 × 162 mm

Envelope 132 × 220 mm
Photo Paper 4 × 6 in
Panoramic 210 × 594 mm
B4 257 × 364 mm *
US B 11 × 17 in *
A3 297 × 420 mm *
Super A3/B 329 × 483 mm *
B3 364 × 514 mm *
A2 420 × 594 mm *
US C 17 × 22 in *
User Defined (See Creating
User Defined Paper Sizes for
instructions.)

5 If you did not or cannot select the number of copies you want to print in
your application program’s Print dialog box, choose the number in the
Copies box. Don’t select the number of copies here and in your
application’s Print dialog box; you may get twice the number of copies
you want.
6 If you’re printing multiple copies of a multi-page document and you
want the copies printed in sets, click the Collate checkbox. The page
graphics change to show collated documents.
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7 If you’re printing a multi-page document and want the last page printed
first so the pages come out without needing to be reordered, click the
Reverse Order checkbox. The page graphics change to show later
pages printing first.

The Rotate by 180°
setting lets you print
the lower portion of a
document first, with a
bottom margin as
small as 0.12 inch
(3 mm) and a top
margin as small as
0.55 inch (14 mm).
This option is not
available with
Windows 3.1.
When you select
Maximum as the
Printable Area
setting, print quality
may decrease in the
expanded printable
area in the bottom
margin.

Advanced Printing

8 Select the direction of printing on the page with the Orientation options.
To print your document oriented as shown in one of the following
illustrations, select the options listed below it.

Portrait

Portrait and
Rotate by 180°

Landscape

Landscape and
Rotate by 180°

9 The Standard Printable Area setting uses the maximum printable area
of your paper with a minimum bottom margin of 0.55 inch (14 mm). To
decrease the minimum bottom margin to 0.12 inch (3 mm), set the
Printable Area setting to Maximum. To center your document on the
page using either setting, select the Centered checkbox.
10 Click a tab for the settings you want to check or change next, or click
OK to print your document.
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Creating User Defined Paper Sizes
You can create up to 10 custom paper sizes (one in Windows 3.1) and
add them to the Paper Size list using the User Defined option. This is
useful if you’re printing a custom size document, such as a banner. You
can select any width from 3.5 to 9.5 inches, and any height (length) from
3.5 to 44 inches.
Follow these steps to create a User Defined paper size:
1 Follow the steps in Printing from Windows to access the printer
software, then click the Paper tab.
2 Click the Paper Size list and scroll to the bottom of it using the arrows
or scroll bar.
3 Click the User Defined option. You see one of the following dialog
boxes:

Windows 3.1
Windows 95, 98, NT
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In Windows 95, 98,
and NT, the Paper
Width and Paper
Height units are in
hundredth of an inch
(or centimeter)
increments. For
example, 850 equals
8.50 inches.

4 Windows 95, Windows 98, or Windows NT
Type a name (up to 24 characters) for your custom paper size in the
Paper Size Name field. Then select a Paper Width and Paper Height
for the paper. To use centimeters instead of inches, click the 0.01cm
option. When you’re finished, click Save. The paper size name
appears in the Paper Size list in the dialog box. Add more sizes if you
want, and click OK when you’re done.
Windows 3.1
You can create only one User Defined paper size. Type the width in
the Paper Width field and the length in the Paper Height field. Then
click OK.
5 You see the Paper tab again. The paper size name you defined is
added to the Paper Size list and selected as the current setting. (In
Windows 3.1, the setting is named User Defined.)
6 Click a tab for the settings you want to check or change next, or click
OK to print your document.

Changing or Deleting a Custom Paper Size
Windows 95, Windows 98, or Windows NT
1 Click User Defined in the Paper Size list.
2 On the User Defined Paper Size dialog box, select the custom paper
name in the Paper Size list and change the Paper Width, Paper
Height, and/or Unit settings as necessary, or click Delete.
3 Click OK when you’re done.
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Windows 3.1
You can change the custom paper size, but cannot delete it.
1 Click User Defined in the Paper Size list.
2 On the User Defined Paper Size dialog box, change the Paper Width
and Paper Height settings as necessary.
3 Click OK when you’re done.

Selecting Paper Options on a Macintosh
The Paper Size and Orientation options for your printer software are on
the Page Setup dialog box. The options for collating and reversing the
page order are on the Layout dialog box. Follow the steps in these
sections for selecting the paper options:
◗ Choosing Paper Size and Orientation Options
◗ Selecting Print Order Options
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Choosing Paper Size and Orientation Options
Follow these steps to select the Paper Size and Orientation:
1 Create your image or document in your application software.
2 Open the File menu and select Page Setup. You see the Page Setup
dialog box:
Click to select your
Paper Size

Printer graphic
reflects changes
to Orientation and
Printable Area
settings

Click to select your
Orientation options
Click to select
your Printable
Area options

3 Click the Paper Size pop-up list to select the size of paper you loaded
in the printer.
A4 210 × 297 mm
B5 182 × 257 mm
A5 148 × 210 mm
Letter 8 1/2 × 11 in
Legal 8 1/2 × 14 in
Executive 7 1/4 × 10 1/2 in
Half Letter 5 1/2 × 8 1/2 in
A6 Index card 105 × 148 mm

Index card 5 × 8 in
Index card 8 × 10 in
Envelope #10 4 1/8 × 9 1/2 in
Envelope DL 110 × 220 mm
Envelope C6 114 × 162 mm
Envelope 132 × 220 mm
EPSON Photo Paper 4 × 6 in
Panoramic 210 × 594 mm

If you don’t see the exact size you need, you can create a custom
paper size; see Creating Custom Paper Sizes.
Advanced Printing
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4 Select the direction of printing on the page with the Orientation
options. To print your document oriented as shown in one of the
following illustrations, select the options listed below it.
The Rotate by
180 degrees setting
lets you print the
lower portion of a
document first, with a
bottom margin as
small as 0.12 inch
(3 mm) and a top
margin as small as
0.55 inch (14 mm).
When you select
Maximum as the
Printable Area
setting, print quality
may decrease in the
expanded printable
area in the bottom
margin.

Advanced Printing

Portrait

Portrait and
Rotate by
180 degrees

Landscape

Landscape and
Rotate by
180 degrees

5 The Standard Printable Area setting uses the maximum printable area
of your paper with a minimum bottom margin of 0.55 inch (14 mm). To
decrease the minimum bottom margin to 0.12 inch (3 mm), set the
Printable Area setting to Maximum. To center your document on the
page using either setting, select the Centered checkbox.
6 To collate multiple copies of a multi-page document or reverse the
order in which pages are printed, see Selecting Print Order Options for
instructions.
If you’ve finished selecting options, click OK to close the Page Setup
dialog box. Then select Print from the File menu to print your
document.

Page 52

color900.book Page 53 Wednesday, January 6, 1999 12:39 PM

Creating Custom Paper Sizes

To delete a custom
paper size, click the
Customize button.
Then select the
name of the custom
paper size and click
Delete.

You can create up to 8 custom paper sizes and add them to the Paper
Size list. This is useful if you’re printing a custom size document, such as
a banner. You can select any width from 3.5 to 9.5 inches, and any height
(length) from 3.5 to 44 inches.
Follow these steps to create a custom paper size:
1 Open your application’s File menu and select Page Setup.
2 Click the Customize button. You see the following dialog box:

3 Click the New button. Width and Height fields and Inches and cm
buttons appear on the screen.
4 Type the width and length of your custom paper in the Width and
Height fields. If you need to change from inches to centimeters, click
the cm button.
5 Type a name for your paper size in the New Paper Size field, then
click OK. The name is added to the Paper Size list and selected as the
current setting in the Page Setup dialog box.
6 Click OK to return to the Page Setup dialog box.
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Selecting Print Order Options
Follow these steps to use the Collate and Reverse Order options:
1 Open your application program’s File menu and select Print.
2 Click the

Layout icon. You see the Layout dialog box:

For information on the
other settings on the
Layout dialog box,
see Choosing Print
Layout Options on a
Macintosh.
Print Order
options

3 If you’re printing multiple copies of a multi-page document and you
want the copies printed in sets, click the Collate checkbox. The page
graphics change to show collated documents.
4 If you’re printing a multi-page document and want the last page printed
first so the pages come out without needing to be reordered, click the
Reverse Order checkbox. The page graphics change to show later
pages printing first.
5 Click OK to close the Layout dialog box.
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Selecting Print Layout Options
The print layout options let you reduce or enlarge almost any size
document to print on your printer. You can also select options to proof
multiple pages on one sheet of paper, add page frames, and add a
predefined or custom watermark.
Layout options
are not available
with Windows 3.1.

Follow the steps in the section for your operating system:
◗ Choosing Print Layout Options in Windows
◗ Choosing Print Layout Options on a Macintosh

Choosing Print Layout Options in Windows
Follow the steps in these sections to use options in the Layout dialog box:
◗ Reducing and Enlarging Your Document Size
◗ Using Multiple Print Layouts and Page Frames
◗ Adding a Watermark
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Reducing and Enlarging Your Document Size
When you want to make the printed size of a document different from
its original size, you can use your printer software’s Reduce/Enlarge
settings. You can make the document fit into the printable area on a
selected paper size or you can choose to reduce or enlarge it to a
selected percentage of its original size.
Follow these steps to reduce or enlarge your document size:
1 Create your document in your application software.
2 Follow the steps in Printing from Windows to access the printer
settings dialog box, then click the Paper tab.
3 Click the Paper Size list and select your document’s size as
determined by your application.
4 If the Paper Size setting you selected is within the maximum paper
size that can fit on your printer, but you want to enlarge or reduce the
document, go to step 6.
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5 If the Paper Size setting
you selected is larger
than the maximum size
that can be printed on
your printer, you see the
following dialog box:

Output
Paper list

In the Output Paper list,
select the actual size of
the paper loaded in the
printer and click OK. This automatically turns on the Fit to Page
setting so the document fits into the printable area on the output paper
you select.
The selected Paper Size, reduction percentage, and Output Paper
settings now appear above the printer graphic.
Paper Size setting
reduction percentage
Output Paper setting

If you want to adjust the proportions or sizes further, go to step 6. If
you’re ready to print, go to step 8.
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6 Click the Layout tab. You see the Layout dialog box:

Reduce/Enlarge settings

If you previously
selected a Paper Size
setting that is larger
than the maximum
paper size for your
printer and then
choose Normal,
the Paper Size
changes to
Letter 8 1/2 × 11 in.

7 Select one of the following Reduce/Enlarge settings:
◗ Select Normal to set the print proportion to 100%.
◗ Select Fit to Page to automatically reduce or enlarge the document
to fit on the paper size loaded in the printer. The Paper Size option
beneath the Fit to Page setting becomes active, if necessary; select
the size of paper loaded in the printer.

Select Fit to Page, then
select the size of paper
loaded in the printer here

◗ Select Custom, then select a percentage (10% to 400%) in the
Scale to field to resize the document by a specific amount.
Advanced Printing
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8 If you’re finished selecting Layout options, click OK.
If you want to select more options, see Using Multiple Print Layouts
and Page Frames and Adding a Watermark.

Using Multiple Print Layouts and Page Frames
If you’re printing a multi-page document, but you want a quick proof of the
images on each page printed on one piece of paper, you can select Print
Layout options in the printer software. You can choose the way the pages
are placed on the paper and add a lined frame to each page.
Follow these steps to use the Print Layout options:
1 Follow the steps in Printing from Windows to access the printer
settings dialog box.
2 Click the Layout tab. You see the Layout dialog box.
3 To print multiple pages of your document on one sheet of paper, select
either the 2 Pages or 4 Pages button.

Click a button to select a
multi-page print layout
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4 If the page order in the on-screen graphic is how you want your
document printed, go to step 5.
To change the page order, click the Page Order button. Then select
the page order you want to use from the Print Layout dialog box that
appears.
5 If you want to frame each page’s contents with a black line, one dot
wide, click the Print page frames checkbox.

To add a custom
watermark, you
must first create the
watermark as a bitmap
in an application
program that can
create bitmap files.
See your application’s
documentation for
instructions.

6 If you’re finished selecting Layout options, click OK. If you want to
select more options, see Reducing and Enlarging Your Document Size
and Adding a Watermark.

Adding a Watermark
You can add a watermark to each page in your document to emphasize
its purpose or indicate how it should be handled. For example, you may
want to add a watermark of the word “Confidential” to documents you
don’t want distributed to other parties. Or you can add a custom bitmap of
your company logo so your document looks like printed letterhead.
Follow these steps to add a watermark:

If you selected a
multi-page print layout
option (as described in
Using Multiple Print
Layouts and Page
Frames), your
watermark will appear
on each page in the
layout.
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1 Follow the steps in Printing from Windows to access the printer
settings dialog box.
2 Click the Layout tab. You see the Layout dialog box.
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3 To select a watermark, click the WaterMark drop-down list.
WaterMark
drop-down list

Then highlight one of the following watermarks:
Confidential
Draft
Urgent
Priority
Hot

Do Not Copy
For Your Eyes Only
Review Copy
Top Secret
Duplicate

To turn off your watermark, select None from the drop-down list.
4 To change the watermark or specify how it appears, click the Settings
button. You see the following dialog box:
Click here to select a
predefined watermark
Click here to load a custom
watermark you’ve created
See how your
selections will
look in the
Layout graphic

Advanced Printing

Specify how you want your
watermark to look using
these options
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5 To load a custom watermark you’ve created as a bitmap file in an
application program, click the User Defined button. You see the
following dialog box:
You can create up to
10 custom watermarks
using any bitmap file
up to 15MB in size.
With Windows NT, the
file can be any size.
To delete a custom
watermark from the
list, click the User
Defined button, select
the watermark, and
click Delete.

Click Browse to select your
bitmap file
Then type a name for your
custom watermark here
and click Save

Click the Browse button. You see a file selection dialog box. Navigate
to the folder containing the bitmap file you want to use, select the file,
and click OK.
Type a name for the custom watermark (up to 24 characters long) in
the Watermark field. Click the Save button to add it to the list, then
click OK.
The custom watermark now appears as the selected watermark in the
Watermark Settings dialog box and is shown in the on-screen graphic.
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6 Now select the way you want the watermark to appear by choosing the
following options. The on-screen graphic changes to reflect all the
settings you choose.
◗ Position selects where you want the watermark to appear on your
page: Center, Top-Left, Top-Center, Top-Right, Left, Right,
Bottom-Left, Bottom-Center, or Bottom-Right.
◗ Size adjusts the size of the watermark, either larger or smaller, as
you move the slide bar.

If your monitor
displays only 16
colors, the Intensity
adjustments are not
shown in the Layout
graphic.

◗ Color lets you choose a color for your predefined watermark:
Black, Blue, Aqua, Lime, Fuchsia, Red, or Yellow. You cannot
select a color for a custom watermark; it is printed in its original
colors.
◗ Intensity sets the lightness or darkness of the watermark based on
where you move the slide bar.
7 If you’re finished changing Layout options, click OK. If you want to
select more options, see Reducing and Enlarging Your Document Size
and Using Multiple Print Layouts and Page Frames.

Choosing Print Layout Options on a Macintosh
Follow the steps in these sections to use options in the Layout dialog box:
◗ Using the Fit to Page Option
◗ Adding a Watermark
◗ Using Multiple Print Layouts and Page Frames
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Using the Fit to Page Option
When you want to make the printed size of a document different from its
actual size, you can use your printer software’s Fit to Page option to
proportion it to fit on a selected paper size.
Follow these steps to use the Fit to Page option:
1 Create your image or document in your application software.
2 Open the File menu and select Page Setup. You see the Page Setup
dialog box.
3 Click the Paper Size list and select the original size of your document.
4 Click OK to close the Page Setup dialog box.
5 Now open the File menu and select Print.
6 On the Printer Settings dialog box, click the
the Layout dialog box:

Layout icon. You see

Fit to Page
settings

Advanced Printing
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7 Select one of the following Fit to Page options:
◗ Select Off to set the print proportion to 100%.
◗ Select On to automatically reduce or enlarge the document to fit on
the paper size loaded in the printer.
The Paper Size option beneath the Fit to Page setting becomes
active.

Select the paper size you’ve
loaded in the printer here

Document size

Selected paper size

Now select the size of the paper you’ve loaded in the printer. This
automatically sets the correct reduction or enlargement to fit the
document into the printable area on the selected paper size. The
selected document size and paper size settings now appear
beneath the paper graphic.
8 If you’re finished selecting Layout options, click OK.
If you want to select more options, see Adding a Watermark and Using
Multiple Print Layouts and Page Frames.
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Adding a Watermark

To add a custom
watermark, you must
first create the
watermark as a PICT
file in an application
program that can
create PICT files. See
your application’s
documentation for
instructions.
If you selected a
multi-page print
layout option (as
described in Using
Multiple Print Layouts
and Page Frames),
your watermark will
appear on each page
in the layout.

Advanced Printing

You can add a watermark to each page in your document to emphasize
its purpose or indicate how it should be handled. For example, you may
want to add a watermark of the word “Confidential” to documents you
don’t want distributed to other parties. Or you can add a custom PICT file
of your company logo so your document looks like printed letterhead.
1 Open an application and select a document to print.
2 Open the File menu and click Print.
3 In the printer settings dialog box, click the

Layout button.

4 To use one of the predefined watermarks listed below, click the arrow
in the Name list in the Watermark box and select the watermark. Then
continue with step 6.
Confidential
Draft
Urgent
Priority
Hot

Do Not Copy
For Your Eyes Only
Review Copy
Top Secret
Duplicate
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5 To load a custom watermark you’ve created as a PICT file in an
application program, click the Add/Delete button. You see the
following dialog box:
You can create
up to 10 custom
watermarks from
PICT files up to 1MB
in size.
To delete a custom
watermark from the
list, click the
Add/Delete button,
select the watermark,
and click Delete.

Click the Add button to
select a PICT file

Click the Add button. You see a dialog box for selecting files. Navigate
to the folder containing the PICT file you want to use, select the file,
and click Open.
The name of your PICT file appears in the Mark Name field and is
added to the Watermark List. Click the Save button to close the dialog
box.
The custom watermark now appears as the selected watermark in the
Layout dialog box and is shown in the layout graphic.
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6 Now select the way you want the watermark to appear by choosing the
following options. The layout graphic changes to reflect all the settings
you choose.
◗ Color lets you choose a color for your predefined watermark:
Black, Blue, Aqua, Lime, Fuchsia, Red, or Yellow. You cannot
select a color for a custom watermark; it is printed in its original
colors.
If your monitor
displays only 16
colors, the Intensity
adjustments are not
shown in the Layout
graphic.

◗ Intensity sets the lightness or darkness of the watermark based on
where you move the slidebar.
◗ To adjust the size and position of the watermark, move the cursor
over the Layout graphic. Four boxes appear in the corners of the
graphic and the cursor changes to a hand.

Click and drag anywhere
in here to move the
watermark
Click and drag one of the
corner boxes to resize the
watermark

Advanced Printing
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To move the watermark, click anywhere inside the graphic and drag
it into one of these positions: center, top-center, upper-right,
middle-right, lower-right, bottom-center, upper-left, middle-left, or
lower-left.
To resize the watermark, move the cursor over one of the corner
boxes; the cursor changes to a pointing hand. Click and drag the
box corner to reduce or enlarge the watermark.
7 If you’re finished changing Layout options, click OK to close the Layout
dialog box.
If you want to select more options, see Using the Fit to Page Option
and Using Multiple Print Layouts and Page Frames.

Using Multiple Print Layouts and Page Frames
If you’re printing a multi-page document and you want a quick proof of the
images on each page printed on one piece of paper, you can select a
Print Layout option in the printer software. You can choose the way the
pages are placed on the paper and add a lined frame to each page.
Follow these steps to use the Print Layout options:
1 Open an application and select a document to print.
2 Open the File menu and click Print. You see the printer settings dialog
box.
3 Click the

Advanced Printing

Layout button. You see the Layout dialog box.
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4 To print multiple pages of your document on one sheet of paper, select
either 2 Pages or 4 Pages in the Pages pop-up list.

Click the arrow and select
a multiple page print layout

5 If the page order of the layout shown in the printer graphic is how you
want your document printed, go to step 6.
To change the page order, click the arrow in the Page Order pop-up
list. Then select the page order you want to use.
6 If you want to frame each page’s contents with a black line, one dot
wide, click the Print page frames checkbox.
7 If you’re finished selecting Layout options, click OK.
If you want to select more options, see Using the Fit to Page Option
and Adding a Watermark.
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Using Print Preview on the Macintosh
You can get a preview of how your document will print with the Print
Preview feature in your Macintosh printer software. Print Preview shows
the results of the following printer software settings on your document:
◗ Print layout settings such as Fit to Page, Page Order, Watermark,
Reverse Order, and Collate
◗ Page Setup options, such as Paper Size, Orientation, Rotate by 180
degrees, and Printable Area
Follow these steps to use Print Preview:
1 Open an application and select a document to print.
2 Open the File menu and click Print. You see the printer settings dialog
box:
Click the Print Preview icon
The Print button
changes to the
Preview button

3 Click the
Print Preview icon. The Print button changes to the
Preview button.

Advanced Printing
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4 Click the Preview button. You see the print preview dialog box:
Page control
buttons

Help, Cancel,
and Print buttons

Preview image

Preview sizing
buttons

5 The first preview page is the first page of your document. To change
the preview page, click the
or
button to go back or forward one
page, or enter a page number in the Page field.
6 To change the size of the preview, click the following buttons:
When you click
Cancel, the Preview
and Print dialog
boxes close, but your
current print settings
remain the same.

Advanced Printing

◗ Click

to see the entire page, reduced to fit in the display

◗ Click

to see a mid-size preview

◗ Click

to see the page enlarged with the most detail

7 To print your document, click Print. To close the print preview dialog
box and return to your application, click Cancel.
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Saving Custom Settings
After you’ve fine-tuned your printer settings for a special project, you can
save the settings as a group. Then you can quickly reuse them the next
time you print a similar project. You can save up to 10 groups of settings.
1 Customize your printer settings, then access the Advanced dialog box
as described in Customizing Print Quality and Special Effects.
(In Windows 3.1, access the main printer settings dialog box as
described in Printing from Windows, then click Advanced.)
2 Click the Save Settings button. You see this dialog box:

Windows

Macintosh

3 Type a unique name for your settings (up to 16 characters) and click
the Save button.
4 Click OK to close the Advanced dialog box (not necessary with
Windows 3.1).

Advanced Printing
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To use the settings, click Custom (in Windows 3.1, click Advanced).
Then open the Custom Settings list and double-click the name you
selected for your custom settings group. (On a Macintosh, the custom
settings group is automatically selected.)
To redefine or delete your custom settings, see Revising Custom Settings
or Deleting Custom Settings.

Revising Custom Settings
To change the options in a customized settings group but keep the same
name for it, follow these steps:
1 From the main printer settings dialog box, click Custom (in
Windows 3.1, click Advanced). Then select the name of the custom
settings group you want to redefine in the Custom Settings list.
If you’d rather have a
new custom settings
group, type in a new
name (up to 16
characters) and click
Save.

Advanced Printing

2 Click the Advanced button (in Windows 3.1, click More Settings) and
change the printer settings.
3 When you’re finished changing the settings, click Save Settings. (In
Windows 3.1, click OK to close the More Settings dialog box and then
click Save Settings on the main printer settings dialog box.)
4 Select the name of the custom settings group you’re revising in the
Custom Settings dialog box. (On a Macintosh, it’s automatically
selected.)
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5 If you’re using Windows, click Save. Click OK at the Save As dialog
box to save your revised settings. (Click Cancel to cancel your
changes.)
On a Macintosh, click the Redefine button. Then click Replace at the
confirmation dialog box to save your redefined settings. (Click Cancel
to cancel your changes.)

Deleting Custom Settings
1 From the main printer settings dialog box, click Custom, then click the
Advanced button.
You cannot delete
any of the predefined
document types.

2 Click Save Settings on the Advanced dialog box. (In Windows 3.1,
click Advanced, then click Save Settings on the main printer settings
dialog box.)
3 Select the custom settings group in the Custom Settings box, and click
Delete. Then click OK to confirm the deletion (Windows only).
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Printing on Special Media
Your EPSON Stylus COLOR 900 lets you print on just about any kind of
paper you want to use. You can get great results printing on various sizes
of plain paper, letterhead, and envelopes, but you’ll get even better
results with EPSON’s specially coated ink jet paper.
For the best output, use EPSON’s photo-quality paper: ink jet paper,
glossy film, ink jet cards, and photo paper.
For special projects, you can use a variety of EPSON media designed for
ink jet printers, ranging from transparencies to iron-on transfer paper.
This chapter covers the following:
◗ Selecting Special Media
◗ Media Loading and Handling Guidelines

Printing on Special Media
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Selecting Special Media
When you print on special paper or other media, you need to choose the
correct Media Type and Paper Size settings in your printer software. The
table below lists the available EPSON media and the corresponding
Media Type setting for each one.

Media name

Size

EPSON 360 dpi Ink Jet Paper

Letter
S041060
A4 (8.3 × 11.7 inches) S041059

EPSON Iron-On Cool Peel
Transfer Paper

Letter

EPSON High Quality Ink Jet
Paper

Letter
S041111
A4 (8.3 × 11.7 inches) S041117

EPSON Photo Quality Ink Jet
Paper

Letter
S041062
A4 (8.3 × 11.7 inches) S041061
Legal
S041067

EPSON Photo Quality Ink Jet
Cards

A6 (4.1 × 5.8 inches)
8 × 10 inches

EPSON Photo Quality Self
Adhesive Sheets

A4 (8.3 × 11.7 inches) S041106

EPSON Photo Paper

4 × 6 inches
Letter
A4 (8.3 × 11.7 inches)
Panoramic

Printing on Special Media

Part number

Media Type setting
360 dpi Ink Jet
Paper

S041153/S041155
Photo Quality Ink
Jet Paper

S041054
S041122

S041134
S041141
S041104
S041145

Photo Paper
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Media name

Size

Part number

EPSON Photo Quality Glossy
Film

Letter
S041072
A4 (8.3 × 11.7 inches) S041071
A6 (4.1 × 5.8 inches) S041107

EPSON Photo Stickers Kit
(CD-ROM and paper)
EPSON Photo Stickers
(refill, paper only)

A6 (4.1 × 5.8 inches)

S041144-KIT

A6 (4.1 × 5.8 inches)

S041144

EPSON Ink Jet
Transparencies

Letter
S041064
A4 (8.3 × 11.7 inches) S041063

Media Type setting
Photo Quality
Glossy Film

Ink Jet
Transparencies

To order EPSON paper and other media, contact your dealer or call
EPSON Accessories at (800) 873-7766 (U.S. only). Or visit our website at
www.epsonsupplies.com (U.S. sales only). In Canada, please
call (800) 873-7766 for dealer referral.
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Media Loading and Handling Guidelines
Don’t use any
cleaning sheets
included with special
media; they may jam
inside the printer.

The type of paper or other media you use is one of the most important
factors in determining the quality of your printed output. The following tips
will help you get the best results on any type of paper or other media:
◗ Always handle sheets by the edges, and don’t touch the printable
surface.
◗ Be sure to load the printable (whiter or glossier) side of the media face
up in the sheet feeder.
◗ Load paper only up to the arrow mark on the left edge guide.
◗ Remember to select the correct Media Type and Paper Size for your
paper.
◗ If the special media has protective sheets between the sheets of
media, be sure to remove the protective sheets before printing. After
printing, cover the printed side of your media with these sheets before
storing.
◗ Use ink jet papers within one year of purchase. Use glossy film and
transparencies within six months. Return unused sheets and
envelopes to their original packages as soon as possible. See Paper
for more media storage information.

Printing on Special Media
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◗ Set the thickness lever to
the + position when you
print on envelopes or if
setting for
ink smears when you
envelopes and
print on other thick
media. Open the printer thick paper
cover and position the
lever as shown below.
Then close the cover and
print. (Make sure you
return the lever to the
0 position before you
print on regular media.)

setting for
regular paper

◗ Some media require additional loading instructions. See the following
sections for more information about:
◗ Letterhead, Preprinted Forms, and Legal-size Paper
◗ Envelopes
◗ EPSON Photo Paper
◗ EPSON Photo Quality Ink Jet Cards
◗ EPSON Ink Jet Transparencies
◗ EPSON Photo Quality Self Adhesive Sheets
◗ EPSON Photo Quality Glossy Film
◗ EPSON Photo Stickers
◗ EPSON Iron-On Cool Peel Transfer Paper
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Letterhead, Preprinted Forms, and Legal-size Paper
Load the top edge first. When you load legal-size paper, pull up the paper
support extension and both output tray extensions. Load a maximum of
100 sheets. Select Plain paper as the Media Type and be sure to choose
the correct Paper Size setting in your printer software.

Envelopes

If the stack of
envelopes is more
than 0.4-inch
(10 mm) thick, press
each envelope flat
before stacking it or
load one envelope
at a time.

When you print on envelopes, set the
thickness lever to the + position as
shown. (Make sure you return the lever
to the 0 position before you print on
other media.)
You can load up to 10 envelopes at a
time. Load the envelope flap edge first
and printable side up. Place it against
the right edge guide and adjust the left
edge guide as shown.
Select Plain paper as the Media Type and
choose the correct envelope size as the
Paper Size setting in the printer software.

Printing on Special Media

Page 81

color900.book Page 82 Wednesday, January 6, 1999 12:39 PM

EPSON Photo Paper
You can use EPSON Photo Paper to print photographs that look almost
as good as the ones you get from film processing. EPSON Photo Paper is
available in several sizes.
You can load up to 20 sheets of 4 × 6-inch, letter-size, or A4-size Photo
Paper or 1 sheet of Panoramic paper at a time. Make sure you place a
support sheet beneath the paper if it is included in the paper package.
To keep your printouts looking their best, store them in a resealable
plastic bag or other airtight covering and protect them from heat, humidity,
and direct sunlight. Return unused paper to the original package as soon
as you finish printing.
Keep the following in mind when using EPSON Photo Paper:
◗ Load the paper with the whiter (glossier) side facing up.
◗ If you’re loading Panoramic Photo Paper, pull up the paper support
extension. Then load one sheet of Panoramic Photo Paper and hold
up its top edge while you press the E load/eject button to feed it into
the printer.
Select Photo Paper as the Media Type setting and Panoramic
210 × 594 mm for the Paper Size setting.
Be sure to support your Panoramic Photo Paper as it ejects from the
printer so it doesn’t fall onto the floor.
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◗ If you’re using 4 × 6-inch Photo Paper, follow these steps:

EPSON 4 × 6-inch
Photo Paper is
perforated around the
edges so you can trim
your printouts and
“bleed” the photo—
extend it to the edge
of the paper—on all
sides.

1 When you create the image in your application software, size it to
4.25 × 6.25 inches. You can also use your printer software’s
Reduce/Enlarge settings, as described in Reducing and Enlarging
Your Document Size.
0.67 in

trim size
printed image size

0.24 in
0.12 in

0.12 in 0.24 in

2 Choose these printer software settings:
◗ Photo Paper as the Media Type setting.
◗ Photo Paper 4 × 6 in as the Paper Size setting
◗ Maximum as the Printable Area setting.

Printing on Special Media
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3 Load the paper against the right edge guide with the glossy side
facing up and the perforated margins positioned as shown:

You can load up to 20 sheets of Photo Paper at a time. Make sure
you place the included support sheets A and B beneath the stack,
but don’t print on them.
4 Slide the left edge guide against the left edge of the paper.
5 After you print your picture, fold the paper back and
forth along the perforations and carefully tear the
margins off.
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EPSON Photo Quality Ink Jet Cards
You can load up to 30 cards at a
time. Always place the included
support sheet under the cards. Be
sure the cards are against the right
edge guide and the left edge guide is
against the left edge of the cards.
When you’re ready to print, set the
Paper Size option for the size card
you’re using and set the Media Type
to Photo Quality Ink Jet Paper. If
ink smears on the cards, set the
paper thickness lever to the + position as shown in Envelopes.

EPSON Ink Jet Transparencies
Before you load transparencies, place the included support sheet
or a plain paper sheet beneath the stack. You can load up to
30 transparencies. However, you may get better results by loading one
sheet at a time. Select Ink Jet Transparencies as the Media Type in the
printer software.

EPSON Photo Quality Self Adhesive Sheets
Use these sheets to print labels or stickers. You can load one sheet at a
time. Make sure your adhesive sheets are fully adhered to their backing
sheet before you load them. Set the Media Type to Photo Quality Ink Jet
Paper in the printer software.
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EPSON Photo Quality Glossy Film
Before you load glossy film, put a support sheet (packed with the media)
or a plain paper sheet beneath the stack.
Load up to 20 sheets of glossy film and select Photo Quality Glossy
Film as the Media Type.
You may get better results by loading one sheet at a time. With multiple
sheets loaded, the minimum top margin you can use is 1.2 inches
(30 mm). If you want to use a smaller top margin, load and print one sheet
at a time.
If your media has a cut corner, position it in the printer as shown here.
cut corner

It is best not to
use the Maximum
printable area setting
in the printer software
when printing on
paper with a cut
corner. Part of your
document may print
in the cut out area.

printable side
face up

Remove each sheet from the output tray immediately after it’s printed.
Make sure each sheet is dry before stacking.
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EPSON Photo Stickers
Use these sheets of stickers to print small, decorated photos for use on
cards, invitations, or other items. You’ll need to use an application that
creates photo stickers, such as XLsoft’s StickerPIX.™
Load one sheet of Photo Stickers at a time. Make sure to place support
sheets A and B that came with the stickers beneath the sheet.
Select Photo Quality Glossy Film as the Media Type and
A6 Index 105 × 148 mm as the Paper Size setting in the printer software.

EPSON Iron-On Cool Peel Transfer Paper
You can print photos, company logos, or anything else you want on these
transfer papers, and then iron your images onto T-shirts or other cotton
cloth items.
Load one sheet of transfer paper at a time and select 360 dpi Ink Jet
Paper as the Media Type setting.
Make sure you reverse your image before you print it—especially if it
includes text—so it will read correctly when it’s transferred. You can use
the Flip Horizontal option in your printer software to do this (see
Customizing Print Quality and Special Effects for instructions).
After you print, follow the instructions that came with the paper to iron the
image onto the shirt or other item.
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Managing Print Jobs
Your printer software includes several utilities for managing print jobs.
You can use them to monitor your printer’s status and check on the
current print job or jobs waiting to print.
This chapter provides instructions for the following:
◗ Managing Print Jobs in Windows 95, Windows 98, and
Windows NT 4.0
◗ Managing Print Jobs in Windows 3.1
◗ Managing Print Jobs on a Macintosh

Managing Print Jobs
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Managing Print Jobs in Windows 95,
Windows 98, and Windows NT 4.0
Windows NT 4.0
servers and
workstations include
a messenger service
to alert you to printer
errors or let you know
when a print job is
finished. If you have
appropriate network
access privileges or
you’re controlling
printing from the
server, you can also
set other options. See
your Windows NT
documentation for
details.

Managing Print Jobs

Your printer software offers three ways to manage and monitor your print
jobs:
◗ Progress Meter, which appears each time you send a print job, as
described in Using the Progress Meter. You can turn the Progress
Meter on or off and select other printing options using the Speed &
Progress button; see Displaying the Progress Meter for details.
◗ Spool Manager (not available with Windows NT), which displays your
current print job files and lets you pause and cancel individual print
jobs. The Spool Manager appears in the taskbar at the bottom of the
screen each time you print, as described in Using the Spool Manager.
◗ Status Monitor 2, which provides a variety of print monitoring options,
as described in Using Status Monitor 2.
In addition, the Speed & Progress dialog box lets you optimize your
system for the fastest transfer of data to your printer. See Optimizing Data
Transfer for details.
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Using the Progress Meter
After you send a print job, the Progress Meter window appears on your
screen:
Click to cancel
Click to pause
Click to restart
This information
appears only if you
installed Status
Monitor 2

Click to view the
Status Monitor 2
Printer Status window

The Progress Meter shows the progress of your print job and the status of
your printer. You can use the buttons to cancel, pause, or restart your
print job.
If you installed Status Monitor 2, you also see information about how
much ink you have left and can view the Status Monitor 2 Printer Status
window. See Using Status Monitor 2 for more information.
You can also set up the way your printer software sends print jobs and
select whether or not to display the Progress Meter. See Optimizing Data
Transfer and Displaying the Progress Meter for instructions.
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Displaying the Progress Meter
You can control whether or not the Progress Meter appears when you
send a print job using the Speed & Progress dialog box.
To access the dialog box, you must open your printer software from the
Windows Printers utility as described below.
1 Click Start, point to Settings, then click Printers.
2 Right-click the EPSON Stylus COLOR 900 printer icon and
select Properties (Windows 95 and 98) or Document Defaults
(Windows NT) from the menu.
3 Click the Utility tab. You see the Utility menu:
Utility tab

The Speed & Progress
button is grayed out
when you access your
printer software
through an application.
You can access the
Speed & Progress
dialog box only
through the Windows
Printer Utility, as
described here.

Managing Print Jobs

Speed & Progress
button
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4 Click the Speed & Progress button. You see this dialog box:

Select whether you want
the Progress Meter to
appear or not

For information about other options in the Speed & Progress dialog
box, see Optimizing Data Transfer.
5 Click OK to close the Speed & Progress dialog box and return to the
Utility menu. Then click OK again to exit your printer software.

Managing Print Jobs
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Using the Spool Manager
The Spool Manager (not available with Windows NT) displays the status
of your print job files and lets you control them.
To open Spool Manager while you’re printing, click the EPSON Stylus
COLOR 900 button that appears on the taskbar at the bottom of the
screen. You see the Spool Manager window:
Print job
file

Command buttons

To cancel, pause, resume, or restart a print job, click the job to highlight it;
then click the corresponding command button on the bottom of the
window.

Managing Print Jobs

Page 93

color900.book Page 94 Wednesday, January 6, 1999 12:39 PM

Deleting a Print Job
If you’re having trouble printing, it may be because of a stalled print job.
Follow these steps to delete it and continue printing:
1 Click the EPSON Stylus COLOR 900 button on the taskbar.
2 Click on any print jobs marked Held.
3 Click the Cancel button.
4 Exit Spool Manager and try printing again.

Using Status Monitor 2

You can check printer
status using Status
Monitor 2 only when
your printer is turned
on and connected
directly to your
computer on a
bidirectional port.

Managing Print Jobs

Status Monitor 2 lets you view information about your printer and print
jobs and control how you want printing monitored. Before you can use
Status Monitor 2, you must enable background monitoring for your printer.
Follow the instructions in these sections to use Status Monitor 2:
◗ Opening Status Monitor 2
◗ Turning On Background Monitoring
◗ Setting Up Monitoring Preferences
◗ Using the Status Monitor 2 Main Window
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In addition to the main window, Status Monitor 2 has three detailed status
windows:
◗ Printer Status gives troubleshooting tips and detailed information
about printer errors. See Using the Printer Status Window for more
information.
◗ Job Status shows print jobs that are currently printing or waiting to
print. See Using the Job Status Window for more information.
◗ Status Alert reports errors, low ink levels, and other problems as they
occur. See Setting Up Monitoring Preferences for more information.

Opening Status Monitor 2
To use Status Monitor 2 or to view any of its status windows, you must
first open it. Follow these steps:
1 Make sure your printer is turned on.
2 Click Start, point to
Programs, click the Epson
folder, and click EPSON
Status Monitor 2. You see
the main window:

Managing Print Jobs
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Turning On Background Monitoring
To turn on background monitoring, follow these steps:
If you want to turn off
background
monitoring, follow
steps 1 and 2, then
select Stop
monitoring now.

1 Make sure your printer is turned on and then open Status Monitor 2 as
described in Opening Status Monitor 2. The main window appears.
2 From the Settings menu, select Background Monitoring.
3 Then select either Monitor from restart (to begin background
monitoring after your next system restart) or Monitor now (to begin
background monitoring right away). The
Background Monitoring
icon appears on the taskbar, in the lower right-hand corner of your
screen.
The
Background Monitoring icon remains on your taskbar, even
after you close Status Monitor 2. To reopen the utility, double-click the
icon. The color of the icon also helps you monitor your printer status,
as described in Interpreting the Installed Printer Icon.

Setting Up Monitoring Preferences
Background
monitoring must be
turned on to change
the Background
Monitoring and Status
Alert preferences.

Managing Print Jobs

You can select the way you want Status Monitor 2 to monitor your printer
using the Monitoring Preferences window. Follow these steps:
1 If you haven’t already done so, turn on background monitoring as
described in Turning On Background Monitoring.
2 Click EPSON Stylus COLOR 900 in the Installed Printers list.
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If the Status Alert
window takes a long
time to appear after
you send a print job,
you may want to
decrease the
monitoring interval.
This will make the
Status Alert Window
appear more quickly;
however, shorter
intervals may cause
some applications to
run more slowly.

3 Click the
Monitoring Preferences icon or select Monitoring
Preferences from the Settings menu. (You can also right-click the
printer name in the Installed Printers list and select Monitoring
Preferences from the menu.) You see the Monitoring Preferences
window.
Set the length of the
interval in which you
want Status Monitor 2
to monitor your
printer here
Turn
background
monitoring on
or off for the
selected printer

Select if and when to
use the Status Alert
dialog box: while
printing, when errors
occur, and/or when
ink is low

4 Click the Monitor this printer checkbox.
5 Turn on one or more of the Status Alert options to make the Status
Alert window appear when the selected condition occurs. For example,
if you turn on Show when errors occur, the dialog box appears only if
a printing error occurs. If you select all the options, the dialog box
appears whenever you print, encounter an error, or have low ink
levels.

Managing Print Jobs
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Using the Status Monitor 2 Main Window
Once you’ve enabled background monitoring for your printer and set up
your monitoring preferences, there are two ways to access Status
Monitor 2:
◗ Double-click the
your screen.

icon on the taskbar in the bottom right corner of

◗ Click Start, point to Programs, click the Epson folder, and click
EPSON Status Monitor 2.
When you start Status Monitor 2, you see the main window:
Menu bar
Button bar
Installed
Printer icon
and name

Printer Name, Status,
and Job Count title bars
The number of print
jobs waiting to print
appears here
Brief status messages
appear here

If you see more than one EPSON printer in the Installed Printers list,
Status Monitor 2 has detected printer software for other EPSON printers
on your system. If you connect another EPSON printer, you can monitor it
with Status Monitor 2 the same way you monitor your EPSON Stylus
COLOR 900.

Managing Print Jobs
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You can change the
shape of the Status
Monitor 2 printer
icon by clicking the
Select background
monitoring icon in the
Settings menu and
selecting the icon you
want to use.

Managing Print Jobs

If you have more than one EPSON printer you want to monitor, you can
add them using the Add Printers option in the Settings menu. To save
system resources, you may want to delete any printers from the Status
Monitor 2 list that you don’t need to monitor. To do this, click the printer in
the Installed Printers list and select Delete Printer from the Settings
menu.
You can customize the appearance of items on the Status Monitor 2 main
window using the View menu options or using icons on the button bar. If
you’re monitoring multiple printers, you can reorder them in the Installed
Printers list by clicking Printer Name, Status, or Job Count in the title
bar.
Other options in Status Monitor 2 let you view more details on the printer
or job status, as described in Using the Printer Status Window and Using
the Job Status Window. You can also set when and if you want the Status
Alert window to notify you of changes in your printer status. See Setting
Up Monitoring Preferences for instructions.
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Interpreting the Installed Printer Icon
The various Status Monitor 2 windows and the
Background
Monitoring icon show a printer. The color of the printer indicates the
printer status as follows:

Managing Print Jobs

Color

Status message

Green

Ready to print

Yellow

Paper and/or ink level is low

Red

Paper and/or ink is out, paper is jammed, or a print
error has occurred

Gray or dimmed

Printer is either disconnected from your computer or
turned off
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Using the Printer Status Window
For more details on the status of your printer, you can use the Printer
Status window. You can access the Printer Status window in different
ways, depending on whether or not you’re currently printing.
◗ If you’re currently printing, click the Details button on either the
Progress Meter (see Displaying the Progress Meter) or the Status Alert
(see Using the Status Alert Window).
◗ If you’re not currently printing, access your printer software, click the
Utility tab; then click the EPSON Status Monitor 2 icon.
You can also open Status Monitor 2 as described in Opening Status
Monitor 2, and click your printer name in the Installed Printers list.
Then click the
Printer Status icon or select Printer Status from the
Printer menu.
You see the Printer Status window. The Current Status tab gives printing
status and troubleshooting tips.

Printer graphic changes to
reflect the printer status
(see table below)
If your printer runs out of ink,
click this button to display
cartridge replacement
instructions

Managing Print Jobs

Printer status
messages
appear here
If an error occurs,
troubleshooting
tips appear here
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The printer graphic in the Printer Status window gives status and error
condition information:
Graphic

Condition
Ready to print

Paper isn’t loaded correctly

Paper is jammed

Black ink is out

Color ink is out

A communication error has occurred

Another type of printer error has occurred

The printer is cleaning the print head or charging the ink
cartridges.

Managing Print Jobs
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To check the amount of ink you have, click the Consumables tab.

These graphics indicate the
amount of ink remaining in your
cartridges

(The Printer Information tab doesn’t display information for your printer.)

Using the Job Status Window
The Job Status
window is very similar
to the Spool Manager
window. Both allow
you to pause, cancel,
and restart print jobs.
See Using the Spool
Manager for more
information.

Managing Print Jobs

To view detailed information on the print jobs waiting to print, you can use
the Job Status window (not available with Windows NT). There are two
ways to open the window:
◗ Click the printer name in the Installed Printers list to highlight it and
click the
icon or select Job Status from the Printer menu.
◗ Right-click the printer name in the Installed Printers list and select Job
Status from the drop-down menu.
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You see the Job Status window:
Menu bar

Information on jobs currently printing or waiting to be
printed appears here

To pause or cancel a print job, first click in the Document Name list to
highlight it. Then select either Pause Printing or Cancel Printing from
the Document menu.
To pause or purge all waiting print jobs, select Pause Printing or Purge
Print Jobs from the Print menu.
You can also select or deselect the printer as your Windows default, and
access the printer software to change default settings from the Printer
menu.

Managing Print Jobs
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Using the Status Alert Window
To use the Status Alert window, you must turn on background monitoring
and set the Status Alert Preferences. See Turning On Background
Monitoring and Setting Up Monitoring Preferences for instructions.
The color of the printer icon in the Status Alert window indicates the type
of error, as described in Interpreting the Installed Printer Icon.

Click the printer name to
highlight it, then click Details
to open the Printer Status
window; see Using the Printer
Status Window for more
information
Click here to close the
Status Alert dialog box

Managing Print Jobs
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Optimizing Data Transfer
You can speed up the way your printer software processes multiple-copy
print jobs using options in the Speed & Progress dialog box. You can also
optimize your printer port for the fastest data transfer rate for EPSON
printers, if your computer supports such transfers.
To access the Speed & Progress dialog box, you must open your printer
software from the Windows Printers utility as described below.
1 Click Start, point to Settings, then click Printers.
2 Right-click the EPSON Stylus COLOR 900 printer icon and select
Properties (Windows 95 and 98) or Document Defaults
(Windows NT) from the menu.
3 Click the Utility tab. You see the Utility menu:
Utility tab

The Speed & Progress
button is grayed out
when you access your
printer software
through an application.
You can access the
Speed & Progress
dialog box only
through the Windows
Printer Utility, as
described here.

Managing Print Jobs

Speed & Progress
button
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4 Click the Speed & Progress button. You see this dialog box:

Not available with
Windows NT

If you have more than one
hard disk drive, you can select
a folder for storing multiple
copy print jobs here. You don’t
see this box if you have only
one hard disk drive.

Managing Print Jobs
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5 Select the following options:
◗ High Speed Copies speeds up printing of multiple copies of the
same document using hard disk space as a cache. If you have
multiple hard drives, you can select a high speed copy folder for
storing copies.
◗ EPSON Printer Port (not available with Windows NT 4.0) lets you
optimize the transfer rate of your printer port for EPSON printers
instead of using the Windows default printer port. You may see one
of these messages beneath the EPSON Printer Port option:
◗ High speed (DMA) transfer enabled tells you that you’re
already using fast DMA transfer mode.
◗ For higher data transfer rates, use DMA transfer lets you
know that you can speed up printing by enabling DMA transfers
on your system. See your computer documentation or contact
your computer manufacturer’s technical support for instructions
on using DMA transfers, if your computer supports them.
If you see no message, you cannot enable DMA transfers on your
system.
6 Click OK to close the Speed & Progress dialog box and return to the
Utility menu. Then click OK again to exit your printer software.
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Managing Print Jobs in Windows 3.1
Your Windows printer software includes two management utilities: the
Spool Manager and Despooler.
◗ The Spool Manager starts automatically when you send a job to the
printer. It allows you to print in the background while you continue to
work on your computer and to hold jobs to print at a later time. If you’re
using your printer on a network, it also handles multiple print jobs that
come in at the same time. See the next section for details.
◗ The Despooler also starts automatically when you send a job to the
printer. It displays on your screen to provide printer status information.
See Windows 3.1 for details on the Despooler.

Using the Spool Manager

You may not see the
Spool Manager icon if
Program Manager or
the current window is
maximized. Reduce
the window size to
see the Spool
Manager icon.

Managing Print Jobs

The Spool Manager works like the Windows Print Manager. When you
send a job to your printer, your printer software creates a temporary print
job file, stores it in the C:\TEMP or C:\WINDOWS\TEMP directory, and
assigns it to a print queue. The software then sends the file to your printer
at the right time.
To open Spool Manager, do one of the following:
◗ To open it while you’re printing, click the EPSON Spool Manager icon
at the bottom of your desktop.
◗ You can open Spool Manager at any time by double-clicking the Spool
Manager4 icon in the EPSON program group.
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You see the Spool Manager window:

Queue

Print job file

The Spool Manager window displays the status of your print job files and
lets you control them. You can also control print queues, display of the
Despooler, and the default spool directory. Click Help in the Spool
Manager menu bar for detailed information.

Deleting a Print Job
If you’re having trouble printing, it may be because of a stalled print job.
Follow these steps to delete it and continue printing:
1 Open the Spool Manager as described in Using the Spool Manager.
2 Click on any print jobs marked Held.
3 Open the Document menu and click Delete. Then click Yes.
4 Exit Spool Manager and try printing again.
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Changing the Default Spool Directory
If you get an error message while printing, or printing is very slow, you
can try changing your default spool directory.
1 Make a directory on your hard drive where you want Spool Manager to
store print job files, for example, C:\SPLTEMP.
2 Open the Spool Manager as described in Using the Spool Manager.
3 Make sure EPSON Stylus COLOR 900 is selected, and then choose
Setup from the Queue menu. The Queue Setup dialog box appears.
4 Change the spool directory to the one you created in step 1. Also make
sure Use Print Manager for this port is checked. Then click OK.
5 Choose Default Spool Directory from the Options menu.
6 In the dialog box, change the spool directory to the one you created in
step 1. Then click OK.
7 Close Spool Manager.

Managing Print Jobs
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Managing Print Jobs on a Macintosh
Your Macintosh printer software includes two print job management
utilities: Monitor3 and Status Monitor. It also includes a Configuration
utility for setting up print monitoring options.
◗ If you’re using background printing, Monitor3 starts automatically when
you send a job to the printer. It handles printing while you continue to
work on your Macintosh, lets you track documents that are waiting to
be printed, and lets you set priorities and print times for waiting print
jobs. You can also cancel, pause, or restart a print job. See Using
Monitor3 for details.
◗ The Status Monitor lets you check how much ink you have left. See
Using the Macintosh Status Monitor for details.
◗ The Configuration utility lets you select how you want to be notified of
printer errors and where you want print job files stored. See Selecting
Configuration Options for details.
You can also select background printing options before you print, as
described in Setting Up Background Printing Options.
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Using Monitor3
The Monitor3 utility lets you continue to work on your Macintosh while
your document is printing (however, background printing is slower and
may also slow down your system). You can use the Monitor3 dialog box
to check on your print jobs and cancel, pause, or restart them.
To use this utility, you need to turn on background printing and increase
the memory allocation for Monitor3, as described in Setting Up Monitor3.
You may need to
perform different or
additional steps to
allocate memory,
depending on your
Macintosh OS
version; see your
Macintosh
documentation for
more information.

Setting Up Monitor3
1 Open the Chooser from the Apple menu and select the SC 900 icon.
Then select the port you’re using.
2 Under Background Printing, click On and close the Chooser.
3 To increase the memory allocation, select EPSON Monitor3 in the
Extensions folder in your System folder. Then choose Get Info from
the File menu and set the Memory Requirements to 2000 or 3000K,
depending on your system’s available RAM.

You can also turn on
background printing
while you’re using
your printer software;
see Setting Up
Background Printing
Options for
instructions.

Managing Print Jobs

Page 113

color900.book Page 114 Wednesday, January 6, 1999 12:39 PM

Monitoring Print Jobs with Monitor3
After you send a print job, you see the EPSON Monitor3 dialog box:

If the Monitor3 dialog
box doesn’t appear,
click the current
application icon at the
right end of the menu
bar and select
EPSON Monitor3
from the drop-down
menu.
When background
printing is turned off,
you can cancel your
current print job by
pressing the J and
. (period) keys.

Managing Print Jobs

Current print
job
Jobs waiting to
print

Click to set priorities
or print times for
waiting print jobs

The progress bar tracks the progress of the current print job. To cancel,
pause, or restart a print job (either the current one or any job waiting to
print), click the document’s name to highlight it. Then click one of the
following buttons:
◗ click

to delete

◗ click

to restart

◗ click

to pause
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If you want to change the printing priority of a print job or set a specific
time for it to print, click the Show details arrow at the bottom of the
window. The Priority list becomes active.

If you see a stop sign
icon and the message
Print queue on hold in
the EPSON Monitor3
dialog box, select
Start print queue from
the Printer menu to
release the queue
and resume printing.

Show/Hide details arrow
Priority list box
Settings selected for the
highlighted print job

Click the print job whose priority you want to change. Then click the
Printer list box and select one of the following settings:
◗ Normal prints the job in the order it is received
◗ Urgent moves the job before Normal priority jobs in the print queue
◗ Hold holds the job in the print queue until you’re ready to release it for
printing by clicking
restart
◗ Print Time opens the Set Print Time dialog
box. Enter the date and time you want to
print the document, then click OK

Managing Print Jobs
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Using the Macintosh Status Monitor
You can use the Status Monitor to check the level of ink in your printer.
Follow these steps:
1 Choose Page Setup or Print from the File menu in your application.
You see a printer settings dialog box.
2 Click the

Utility icon. You see the Utility menu:

For information
about these utilities,
see Maintenance
and Transportation

Managing Print Jobs

Page 116

color900.book Page 117 Wednesday, January 6, 1999 12:39 PM

3 Click the EPSON StatusMonitor icon. The software checks the
amount of ink remaining in the printer and displays the Status Monitor
window:

Click to recheck
the ink level

4 To recheck the ink level check, click the Update button. To close the
Status Monitor, click OK.
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Selecting Configuration Options
You can configure the way you want the printer to handle error and
warning messages, ink level checks, and temporary spool folders in the
Configuration Settings dialog box. Follow these steps:
1 Choose Page Setup or Print from the File menu in your application.
You see a printer settings dialog box.
2 Click the

Utility icon. You see the Utility menu.

3 Click the Configuration button. You see the Configuration Settings
dialog box:

Select how you want to
be notified of errors and
warnings
Select where you want
print job files stored
Click here to check for
errors and/or the ink level
before printing
Click here to return to the default settings
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4 Select from the following configuration options:
◗ Error notification lets you select whether you want your system to
beep and display error message text or just display text if your
printer encounters an error.
Warning messages,
such as low ink,
allowing printing to
continue; error
messages are more
serious and cause
printing to stop.

◗ Warning lets you choose whether warning messages beep and
display text or display text only.
◗ Temporary Spool folder and Temporary High Speed Copies
folder let you select the folders on your hard disk that store the
temporary print job and high speed multiple-copy print job files
created when you send a job to the printer. Click the Select button
to change the folder from the default folder shown.
◗ Click the Check for errors before starting to print checkbox if you
want your software to check for errors before starting your print job.
◗ Click the Check the ink level before starting to print checkbox if
you want your software to check for a low ink condition before
starting your print job.
5 When you’re finishing changing your configuration options, click OK to
return to the Utility menu.
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Setting Up Background Printing Options
When background printing is on, your printer software lets you work in
other applications while printing takes place in the background.
Background printing also lets you set up the following printing options:
You can also turn
background printing
on or off in the
Macintosh Chooser.

◗ Turn background printing on or off
◗ Set a priority for the print job in the print queue
◗ Set a specific time for printing the print job
◗ Hold the print job for later printing
Follow these steps:
1 Open an application and select a document you want to print.
2 Open the File menu and click Print. You see the printer settings dialog
box.
3 Click the
box:

Background Printing icon. You see the following dialog

Not available if
background printing
is turned off

4 To turn background printing on or off, click the On or Off button.
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5 To select a priority for your print job in the queue of jobs waiting to
print, click one of the following:
◗ Urgent to print before any Normal priority job
◗ Normal to print in the order the job is received
◗ Print at: to print at the specific time you enter in the day and time in
the fields to the right
◗ Hold to hold the print job in the print queue until you’re ready to
release it using EPSON Monitor 3; see Using Monitor3 for details.
6 Click OK to save your settings and return to the printer settings dialog
box. (Click Cancel if you want to cancel your settings and return.)
7 Click Print to print your document.
If you selected Print at: or Hold, your document is spooled, but held in
the print queue until the print time specified or until released using
EPSON Monitor 3.
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Network Printing
Before you can use your printer on a network, you must configure your
computer as described in the following sections.

For Windows 95 and 98 Users
If your computer is on a Windows 95 or Windows 98 network and you
want other users to share the printer connected to it, you need to:

This section
describes how to use
your printer as a
shared printer on a
network. To connect
your printer directly to
a network without
setting it up as a
shared printer,
consult your network
administrator.

◗ set up the system connected to the printer (host system) so the printer
can be shared
◗ define a path to the printer on each client computer
Before following the steps here, make sure you’ve installed the printer
software on all the computers that will use the printer. See the Start Here
card for instructions.

Setting Up the Host System
Follow these steps to share a printer connected directly to your computer
with other computers on a network:
1 Click Start, point to Settings, then click Control Panel.
2 Double-click Network.
3 Click the File and Print Sharing button.

Network Printing
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4 Select the I want to be able to allow others to print to my printer(s)
check box and click OK.

If a dialog box
requesting the
Windows 95 or 98
CD-ROM appears,
insert the CD-ROM in
the CD-ROM drive,
then follow the
messages on the
screen.

5 In the Network window, click OK.
6 In the Control Panel, double-click Printers.
7 Right click the EPSON Stylus COLOR 900 icon, then click Sharing on
the File menu.
8 Click Shared As, enter printer
information as needed, then
click OK.

If a dialog box
appears requesting
you to restart your
computer, do so.
Then continue with
step 6.

Network Printing
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Setting Up Client Systems
1 Right-click the EPSON Stylus COLOR 900 icon and choose
Properties.
To print from DOS
applications as well
as Windows
applications, click the
Capture Printer Port
button instead of Add
Port. Select the
printer port in the
Device list, then
specify its network
path. Select
Reconnect at logon,
then click OK.

Network Printing

2 Click the Details tab.
3 Click the Add Port button, then click Browse to specify the network
path to the printer.
4 When you return to the Details tab, click OK.
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For Windows NT 4.0 Users
This section tells you how to set up your printer so that other computers
on the network can use it.
This section is written
for users printing
over a small network
only. If you are on a
large network and
would like to share
your printer, consult
your network
administrator.

First, you need to set up the printer as a shared printer on the computer to
which the printer is connected. Then, you must signify the network path to
the printer from each computer to use the printer, and install the printer
software on those computers.

Setting Up Your Printer as a Shared Printer
Follow these steps to share a printer that is connected directly to your
computer with others on a network:
1 Click Start, point to Settings, and click Printers.
2 Select your printer, then click Sharing on the File menu.

Network Printing

Page 125

color900.book Page 126 Wednesday, January 6, 1999 12:39 PM

3 Click Shared and enter the Share Name.

Do not choose
any drivers from
the Alternate
Drivers list.

4 Click OK.
Your printer must be
set up as a shared
resource on the
computer to which it
is directly connected
before you can
access it from
another computer.

Network Printing

Accessing the Printer Through a Network
To access your printer from another computer on the network, follow
these steps:
1 On each computer from which you want to access the printer, click
Start, point to Settings, and click Printers.
2 Double-click the Add Printer icon.
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3 Click Network printer
server, then click Next.

4 Double-click the icon of
the computer that is
directly connected to the
printer. Then click the
printer’s icon.
Be sure to confirm all
network settings with
the network
administrator.

Network Printing

5 Click OK and follow the
on-screen instructions.
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For Macintosh Users
This section tells you how to set up the printer so that you can use it on an
AppleTalk ® network.
This section is written
for AppleTalk
network users only.

First, you need to install the printer software on those computers,
following the instructions on the Start Here card. Then, you must select
the printer in the Chooser.

Selecting the Printer in the Chooser
1 Turn on your printer.
2 Open the Chooser from the Apple menu and click your printer’s icon.
3 If you are using AppleTalk
zones, select the zone you
want to use. A list of all the
printers connected to the
selected zone appears on
the right. Click the name
assigned to the EPSON
Stylus COLOR 900.
4 Click the Background
Printing buttons to turn
background printing on
or off.
5 Close the Chooser.

Network Printing
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Optional Interfaces
Your EPSON Stylus COLOR 900 includes parallel, serial, and USB
interfaces. You can connect it to a PC or Macintosh, or both at the same
time. If you want to connect to another system or to a network, you can
install one of the following EPSON interface boards in your printer:
Type of interface board

Model number

Compatibility

32KB serial

C823071

PC

32KB parallel

C80310*

Type B bi-d parallel

C82345*

Twinax

C823151

PC

Coax

C823141

PC

C823121

Macintosh

Type B Ethernet

C823622

Macintosh/PC

Type B Ethernet

C823632

Macintosh/PC

Type B Ethernet

C823642

Macintosh/PC

LocalTalk®
™

To order an interface board, contact your dealer or call EPSON
Accessories at (800) 873-7766 (U.S. sales only). Or visit our website at
www.epsonsupplies.com (U.S. sales only). In Canada, call
(800) 873-7766 for dealer referral.
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This chapter tells you how to install and use EPSON interface boards in
the following sections:
◗ Using PC Interface Boards
◗ Using Macintosh Interface Boards
◗ Installing Optional Interfaces

Using PC Interface Boards
Before you install the serial interface board in your printer, follow the
instructions that come with the board for setting baud rate and parity. You
may also need to set the board’s handshake timing, error handling, and
other data transfer conventions. Refer to your computer documentation
for information about matching the board’s settings to your computer
system.
If you install the Ethernet board connected to a thin coaxial (10BASE2)
cable, and the printer is the last device on the network, you need to obtain
a 50-ohm terminator. The Ethernet transceiver is included on the EPSON
Ethernet board, so you do not need an adapter box for the printer.

Using Macintosh Interface Boards
If you are planning to install the LocalTalk board, you also need two
LocalTalk Locking Connector Kits (DIN-8 version). Attach one connector
box to the AppleTalk interface on the printer and the other to the printer
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port on the Macintosh. Then attach the LocalTalk cable between the two
connector boxes. For more information, see the instructions that came
with the connector kits.
If you install the Ethernet board connected to a thin coaxial (10BASE2)
cable, and the printer is the last device on the network, you need to obtain
a 50-ohm terminator. The Ethernet transceiver is included on the EPSON
Ethernet board, so you do not need an adapter box for the printer.

Installing Optional Interfaces
Before you install an optional interface board in your printer, make sure
the printer is turned off and all the printer’s lights are off. Then follow
these steps:
To avoid damaging
your printer or
computer, do not
install the interface
board when the
printer is connected
to an electrical outlet.

Optional Interfaces

1 Unplug the power cord from the electrical outlet.
2 Disconnect any interface cables from the printer.
3 Use a Phillips (cross-head)
screwdriver to remove the
two screws securing the
interface cover; then lift off
the cover. Be sure to keep
both screws; you’ll need to
use them again if you
reinstall the cover.
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4 Set any switches and jumpers on the board as described in the
interface board’s manual. If your board has a jumper labeled JG, make
sure that you set it to ON, or the board will not work properly.
5 Slide the interface board
along the slots on both sides
of the compartment. Push it
in firmly to fully insert the
board’s connector into the
printer’s internal socket.
6 Secure the interface board in
the slot with the two screws
included with the board.
7 Connect the proper interface
cable to the interface board
and to your computer. If the cable has a grounding wire, connect it to
one of the screws securing the parallel interface.
If you are using more than one computer, reconnect the other interface
cable as well.
8 Make sure the printer is turned off. Then plug in the power cord.
In most cases, the printer automatically detects the interface you’re using.
However, if you have trouble printing through an installed interface board,
you may need to change the printer’s I/F (interface) mode setting. See
“Using Your Printer with DOS” in your Printer Basics book.
To remove the interface board, follow steps 1 and 2 in this section.
Remove the screws securing the board and carefully pull it out of the
internal printer socket. Then replace the interface cover and screws you
removed in step 3.
Optional Interfaces
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Maintenance and
Transportation
It’s easy to keep your EPSON Stylus COLOR 900 printer working at its
best. Just follow the simple instructions in this chapter for:
◗ Cleaning the Print Head
◗ Replacing an Ink Cartridge
◗ Aligning the Print Head
◗ Cleaning the Printer
◗ Transporting the Printer

Maintenance and Transportation
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Cleaning the Print Head
If you don’t turn on
your printer for a long
time, the printer
quality may decline.
It’s a good idea to turn
on your printer at least
once a month to
maintain good print
quality.

If your printed image is unexpectedly light or faint, or dots are missing
from the image, you may need to clean the print head. This unclogs the
nozzles so they can deliver ink properly.
Cleaning the print head uses ink, so clean it only if print quality declines.
You can clean the print head in either of the following ways:
◗ Using the Head Cleaning Utility in your printer software (when
connected to a local port, not over a network)
◗ Using the Control Panel buttons on your printer
Always wait until your document has finished printing before cleaning the
print head.

Using the Head Cleaning Utility
Follow these steps to run the Head Cleaning utility:
Don’t use any
cleaning sheets; they
may jam inside the
printer.

1 Make sure the printer is turned on but not printing, and both the B black
and A color ink out lights are off.
2 Start an application and open a document.
3 Access the printer settings dialog box as described in Printing from
Windows or Printing from a Macintosh.
4 Click the Utility tab (Windows) or the

Utility icon (Macintosh).

5 On the Utility menu, click the Head Cleaning icon.
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6 Follow the instructions on the screen to clean the print head. Cleaning
takes a couple minutes, during which the printer makes some noise
and the P power light flashes.
Never turn off the
printer while the
P power light is
flashing, unless the
printer hasn’t moved
or made any noise for
more than 5 minutes.

When the Ppower light stops flashing, run a nozzle check to test the
results and reset the cleaning cycle.
7 Make sure paper is loaded in the printer and click Print nozzle check
pattern (Windows) or Confirmation (Macintosh). Then click Next. The
nozzle check pattern prints on your printer; see Examining the Nozzle
Check Pattern for details.
8 If the nozzle check pattern is complete, click Finish.
If the pattern is missing dots, click Clean to run another cleaning cycle.
If you don’t see any improvement after cleaning two or three times,
check the print quality solutions in Improving Print Quality.

Using the Control Panel
Follow these steps to clean the print head:
1 Make sure the printer is turned on and not printing, and that both
the B black and A color ink out lights are off.
2 Press the R cleaning button and hold it down for three seconds.
Cleaning takes a couple minutes, during which the printer makes some
noise and the P power light flashes.
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3 After the P power light stops flashing, print a page to test the print
quality and reset the cleaning cycle.
If you’re connected directly to the printer, run a nozzle check. Go to
step 4.
Never turn off the
printer while the
P power light is
flashing, unless the
printer hasn’t moved
or made any noise for
more than 5 minutes.

If you’re using DOS or printing over a network, open an application and
print a document containing black and color data. Then go to step 8.
4 Start an application, open a document, and access the printer settings
dialog box as described in Printing from Windows or Printing from a
Macintosh.
5 Click the Utility tab (Windows) or the
see the Utility menu.

Utility icon (Macintosh). You

6 Make sure paper is loaded in the printer and click the Nozzle Check
icon, then click Next. The nozzle check pattern prints on your printer;
see Examining the Nozzle Check Pattern for details.
7 If the nozzle check pattern is filled in completely, click Finish.
If the pattern is missing dots, click Clean to run another cleaning cycle.
8 If you don’t see any improvement after cleaning two or three times,
check the print quality solutions in Troubleshooting.
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Examining the Nozzle Check Pattern
Examine the nozzle check pattern you print. It should look something like
this, with the lower pattern colored magenta, cyan, and yellow:

Each staggered horizontal and straight vertical line should be complete,
with no gaps in the dot pattern. If your printout looks okay, you’re done. If
any dots are missing, as shown below, clean the print head again; see
Cleaning the Print Head for instructions.
missing dots

missing dots
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Replacing an Ink Cartridge
When the B black or A color ink out light flashes, the indicated cartridge
is low on ink. This is a good time to make sure you have a new cartridge.
When the light stays on, the cartridge is empty and you need to replace it.
Use these EPSON ink cartridges within six months of installing them and
before the expiration date on the package:
To ensure good
results, use genuine
EPSON cartridges
and do not refill
them. Other products
may cause damage
to your printer not
covered by EPSON’s
warranty.

Black ink cartridge T003011
Color ink cartridge T005011
When you need new ink cartridges, contact your dealer or call EPSON
Accessories at (800) 873-7766 (U.S. sales only). Or visit our website at
www.epsonsupplies.com (U.S. sales only). In Canada, please call
(800) 873-7766 for dealer referral.
If you need to replace an ink cartridge before the lights flash (because the
ink is too old, for example), follow the instructions in Replacing an
Outdated Ink Cartridge.
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Removing and Installing Ink Cartridges
You can replace a cartridge when the B black or A color ink out light is
either flashing or on. (If you perform these steps when both ink out lights
are off, the printer cleans the print heads, as described in Cleaning the
Print Head.)
Follow these steps to replace ink cartridges:
1 Remove the new ink cartridge from its packaging.
2 Remove only the yellow part of the tape seal on top as shown below.
Don’t pull off the blue portion or try to remove the clear seal
underneath the cartridge.
Remove the yellow tape

You must remove the
yellow tape from the
top of the cartridge or
you will permanently
damage it. Do not
remove the clear seal
from the bottom of
the cartridge; ink will
leak.

black cartridge

color cartridge

3 Make sure the printer is turned on and not printing, then open the
printer cover.
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4 Press the R cleaning button and hold it for about three seconds until
the print head moves left and the P power light begins flashing. The
print head moves to the black or color cartridge replacement position,
depending on which ink cartridge is empty.
Don’t open the clamp
or remove a cartridge
except to replace
it with a new one.
Once you remove a
cartridge, you can’t
reuse it, even if it
contains ink.

5 Pull up the ink cartridge clamp. The cartridge rises up from its holder.

To avoid damaging
the printer, never
move the print head
by hand.
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6 Lift the cartridge out of the printer and dispose of it carefully.
7 Lower the new ink cartridge into its holder with the label facing up and
toward the back of the printer. Then press down the ink cartridge
clamp until it locks in place.
If ink gets on your
hands, wash them
thoroughly with soap
and water. If ink gets
into your eyes, flush
them immediately
with water.

8 If you need to replace the other ink cartridge, repeat steps 4 through 7
before going on to step 9.
Never turn off the
printer while the
P power light is
flashing, unless the
printer hasn’t moved
or made any noise for
more than 5 minutes.

9 Press the R cleaning button and close the printer cover.
The printer moves the print head and begins charging the ink delivery
system. The P power light flashes, and the printer makes various
sounds.
Charging takes about one minute. When it’s finished, the
P power light stops flashing and stays on.
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Replacing an Outdated Ink Cartridge
If an ink cartridge is more than six months old, you may need to replace it.
How can you tell? You may notice that your printouts don’t look as good
as they used to. If print quality doesn’t improve after cleaning and aligning
the print head, you can replace one or both cartridges.
Follow these steps to replace an ink cartridge before the B black or
A color ink out light is flashing or on:
1 Remove the new ink cartridge from its packaging.
2 Remove only the yellow part of the tape seal on top as shown below.
Don’t pull off the blue portion or try to remove the clear seal
underneath the cartridge.
Remove the yellow tape

You must remove the
yellow tape from the
top of the cartridge or
you will permanently
damage it. Do not
remove the clear seal
from the bottom of
the cartridge; ink will
leak.

black cartridge

color cartridge

3 Make sure the printer is turned on and not printing, then open the
printer cover.
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4 Press the E load/eject button and hold it down for three seconds until
the print head moves left to the black ink cartridge replacement
position and the P power light begins flashing.
To avoid damaging
the printer, never
move the print head
by hand.

5 If you need to replace only the color ink cartridge, press the
E load/eject button again until the print head moves to the color ink
cartridge replacement position.
6 Pull up the ink cartridge clamp. The cartridge rises up from its holder.

Don’t open the clamp
or remove a cartridge
except to replace it
with a new one.
Once you remove a
cartridge, you can’t
reuse it, even if it
contains ink.
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7 Lift the cartridge out of the printer and dispose of it carefully.
8 Lower the new ink cartridge into its holder with the label facing up and
toward the back of the printer.
If ink gets on your
hands, wash them
thoroughly with soap
and water. If ink gets
into your eyes, flush
them immediately
with water.

9 Press down the ink cartridge clamp until it locks in place.
10 Press the E load/eject button. The print head moves to the color ink
cartridge replacement position. If you need to replace the color ink
cartridge, repeat steps 6 through 9. Then continue with step 11.
11 Press the E load/eject button again and close the printer cover.
Never turn off the
printer while the
Ppower light is
flashing, unless the
printer hasn’t moved
or made any noise
for more than
5 minutes.

The printer moves the print head and begins charging the ink delivery
system. The P power light flashes and the printer makes various
sounds.
Charging takes about one minute. When it’s finished, the P power light
stops flashing and stays on.
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Aligning the Print Head
If your printouts contain misaligned vertical lines, you may need to align
the print head.
Load paper that’s at
least 8.27 inches
(210 mm) wide. This
prevents ink from
spraying inside the
printer and smudging
your printouts.
For the best results,
load EPSON ink jet
paper in the printer
whenever you check
the print head
alignment.

If you are using Windows or Macintosh, you can use the Print Head
Alignment utility in your printer software. Your printer must be connected
to a local port, not on a network, to use this utility.
If you are using DOS, see Using the DOS Print Head Alignment Utility or
Using the Control Panel Buttons.

Using the Print Head Alignment Utility
Follow these steps:
1 Make sure the printer is turned on and letter-size paper is loaded.
2 Start an application and open a document.
3 Access the printer settings dialog box as described in Printing from
Windows or Printing from a Macintosh.
4 Click the Utility tab (Windows) or the
see the Utility menu.

Utility icon (Macintosh). You

5 Click the Print Head Alignment icon.
6 Follow the instructions on the screen to print a test page and select the
correct alignment.
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Using the DOS Print Head Alignment Utility
Follow these steps:
1 Insert the printer software CD-ROM into your CD-ROM drive.
You must install this
utility in DOS; you
cannot install this
utility from within
Windows.

2 Type D:\SETUP at the DOS prompt. (If your CD-ROM drive has a
different drive letter, or if you are using the diskette version, substitute
the appropriate letter for D.) Then press Enter, and follow the
directions on the screen to install the print head alignment utility.
3 After installing the utility, type C:\EPCALIB2 (where C is your hard disk
drive letter). Then press Enter. The following window appears:

4 Make sure EPSON Stylus COLOR 900 is selected. Click Next, then
follow the directions on the screen to align the print head.
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Using the Control Panel Buttons
If you cannot use the print head alignment utility program that came with
your printer, follow these steps to align the print head:
1 Make sure that letter-size paper is loaded in the sheet feeder.
2 While holding down the R cleaning button, press the P power button
to turn on the printer. Then release both buttons.
3 The S paper out light flashes for about three seconds. While it is
flashing, press the E load/eject button.
If you don’t press the
E load/eject button in
step 3, the printer
enters default-setting
mode. If this
happens, turn off
the printer and return
to step 2.

The printer prints a sheet of instructions in English, French, German,
Italian, Spanish, and Portuguese explaining how to align the print
heads. Follow these instructions.
4 After aligning the print head, turn off the printer to exit print head
alignment mode.
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Cleaning the Printer
To keep your printer working at its best, you should clean it several times
a year, following these steps:
Don’t touch the gears
inside the printer.
Never use alcohol or
thinner for cleaning;
they can damage the
printer components
and case.

1 Turn off the printer, unplug the power cord, and disconnect the printer
cable.
2 Remove all the paper from the sheet feeder.
3 Clean the exterior of the printer with a soft, damp cloth.
4 Clean ink out of the printer’s interior with a soft, damp cloth.

Don’t use a hard or
abrasive brush.
Don’t get water on the
printer components.
Don’t spray lubricants
or oils inside the
printer.
Don’t use any
cleaning sheets
included with special
media; they may jam
inside the printer.
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Transporting the Printer
If you move your printer some distance, you need to prepare it for
transportation in its original box. Follow these steps:
1 Turn on the printer and wait until the print head locks in the far right
position. Then turn off the printer.

To avoid damage,
always leave the ink
cartridges installed
when transporting
the printer.

2 Unplug the power cord from the electrical outlet. Then disconnect the
interface cable from the printer.
3 Remove any paper from the printer and remove the paper support.
4 Open the printer cover again. Secure the ink cartridge holder to the
printer with tape as shown below, then close the printer cover.

Be sure to remove
the tape used in
step 4 after installing
the printer in its new
location.
5 Push in the output tray extensions and close the tray.
6 Repack the printer and attachments in the original box using the
protective materials that came with it. See the unpacking sheet that
was packed with your printer.
Be sure to keep the printer level as you transport it. If you notice a decline
in print quality after transporting the printer, clean the print head (see
Cleaning the Print Head); if output is misaligned, align the print head (see
Aligning the Print Head).
Maintenance and Transportation
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Troubleshooting
As you use your printer, you may occasionally experience a paper jam or
other problem. The first thing you should do is diagnose the problem,
following the guidelines in this chapter. Then try the most likely solutions
until the problem is fixed.
This chapter includes the following:
◗ Identifying Printer Parts
◗ Diagnosing Problems
◗ Improving Print Quality
◗ Solving Printing Problems
◗ Solving Printer Software Problems
◗ Fixing Paper Problems
◗ Solving Miscellaneous Printout Problems
◗ Uninstalling Printer Software
◗ Where To Get Help
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Identifying Printer Parts
If you need help identifying the parts of the printer, refer to the following
illustrations:
paper support
right edge guide

sheet feeder

printer cover
left edge
guide
output tray
output tray
extensions

ink cartridge
clamps

control panel

thickness
lever
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Diagnosing Problems
There are a number of ways to diagnose printer problems:
◗ To identify the most common problems, check the printer’s lights; see
Checking the Control Panel Lights for details.
◗ To determine whether the problem is caused by the printer or some
other source, run a printer check. See Running a Printer Check for
instructions.
◗ If you see an error message about your printer settings or have
problems with color quality, you may need to confirm your Printer ID
number. See Confirming the Printer ID Number for details.
◗ If any of the suggested solutions in this chapter tell you to uninstall and
then reinstall your printer software, see Uninstalling Printer Software
for instructions.
◗ For more troubleshooting information, check the Help and ReadMe
files in the EPSON program group or folder.
◗ If none of the suggested solutions in this chapter solve your problem,
contact your EPSON dealer or see Where To Get Help.
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Checking the Control Panel Lights
power light
paper out light

black ink out light
color ink out light

cleaning button

power button
load/eject
button

The four lights on your printer’s control panel show the printer’s status
and alert you to problems like paper jams.
P

The power light is on when the printer is on and ready to print. The power
light flashes when the printer is receiving print data, printing or
performing a maintenance operation such as cleaning the print head.

B or A

When an ink out light flashes, your ink supply is low. Make sure you have
a replacement cartridge.
When an ink out light comes on, you need to replace the ink cartridge.
See Replacing an Ink Cartridge for instructions.
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S

When the paper out light comes on, your paper is out or incorrectly
loaded. Load paper against the right edge guide and slide the left edge
guide over to the paper’s left edge. Then press the E load/eject button to
resume printing.
When the paper out light flashes, you have a paper jam. Turn off the
printer and remove all the paper (including any pieces torn off inside).
Make sure none of the sheets are curled, creased, old, stuck together, or
too thin. Reload the paper against the right edge guide and slide the left
edge guide over to the paper’s left edge. Then turn the printer back on.

PSBA

When the Ppower and S paper out lights flash and the B black and
A color ink out lights come on, jammed paper may be blocking
movement of the print head. Turn off the printer (press the P power
button); remove the jammed paper, wait 15 seconds; then turn the
printer on again. If this does not clear the error, contact your dealer or
EPSON as described in Where To Get Help.
When all the lights flash, your printer may have an internal error. Turn off
the printer (press the P power button); wait 15 seconds; then turn it on
again. If this does not clear the error, contact your dealer or EPSON as
described in Where To Get Help.
When all the lights are off, the printer is not receiving power. Try these
solutions:
◗ Make sure the printer is turned on.
◗ Turn off the printer, plug in the power cord securely, and turn on the
printer.
◗ Make sure the outlet is not controlled by a switch or timer and is
operable.
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Running a Printer Check
You can run a printer check to determine whether the problem comes
from the printer itself or some other source. Follow these steps:
1 Make sure both the printer and computer are turned off.
2 Disconnect the interface cable from the printer.
3 Make sure paper is loaded in the printer.
4 Hold down the E load/eject button, then press and release the Ppower
button. Continue holding down the E load/eject button until the
P power light starts to flash, then release it.
The printer prints one page containing the printer’s ROM version, ink
counter code, and a nozzle check pattern. Only the nozzle check
pattern is shown below:
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5 To end the check, turn off the printer. Then reconnect the interface
cable and turn on your printer and computer.
◗ If the results are satisfactory, the problem lies in your software or
application settings, the interface cable, or your computer.
◗ If the check page does not print correctly, you may have a problem
with your printer. First, try Cleaning the Print Head. Then see the
suggestions in this chapter for possible solutions.

Confirming the Printer ID Number
If you’re using Windows 95, Windows 98, or Windows NT, you can use
the Printer and Option Information utility to confirm the Printer ID. Color
quality may improve after you confirm the ID number.
If you’re using Status Monitor 2, this information is updated automatically.
However, if a message appears prompting you to enter settings or if you
change the printer’s configuration, you’ll need to update the Printer ID
manually. Follow these steps:
1 Make sure letter-size paper is loaded in your printer.
2 Access the main printer settings dialog box as described in Printing
from Windows.
3 Click the Utility tab. Then click the Printer and Option Information
icon.
4 Click the Settings Sheet button. The printer prints the Printer ID on a
sheet of paper.
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5 Make sure the Printer ID shown in the Printer and Option Information
dialog box matches the ID on the Settings Sheet. If they don’t match,
change the ID numbers in the dialog box to match those on the
Settings Sheet.
6 Click OK to exit and save your settings.

Improving Print Quality
You can often improve print quality by doing one of the following:
◗ Clean the print head following the instructions in Cleaning the Print
Head.
◗ Use higher quality paper appropriate for your print job. See Selecting
Special Media for a list of EPSON papers.
◗ Match the Media Type setting in the printer software to the type of
media you loaded in the printer. Then the printer software can
automatically select other settings for the best quality. See Printing
from Windows Applications, Printing from a Macintosh, or Printing on
Special Media for details.
◗ Turn off High Speed mode in the printer software, as described in
Customizing Print Quality and Special Effects.
◗ Make sure you’re not using Economy mode. See Customizing Print
Quality and Special Effects for details.
◗ Check the status of the B black or A color ink out lights, then replace
the ink cartridges, if necessary, as described in Replacing an Ink
Cartridge.
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◗ If you have vertical misalignment, run the Print Head Alignment utility
(see Aligning the Print Head for instructions) or turn off High Speed
mode.
See the following tables for some detailed solutions to print quality
problems:

The printed image has horizontal banding
Possible cause

Solution

The Media Type
setting doesn’t match
the loaded paper.

Make sure the Media Type setting matches the paper you’re using. See
Printing from Windows Applications or Printing from a Macintosh for
instructions.

The printable side of
the paper is face
down.

Remove the paper and reload it with the printable side (whiter) face up.
See Media Loading and Handling Guidelines for instructions.

The print head
nozzles are clogged.

Clean the print head. See Cleaning the Print Head for instructions.

The ink cartridges are
low on ink.

Check the B black and A color ink out lights to see which cartridge you
may need to replace. See Replacing an Ink Cartridge for instructions.

The Maximum
Printable Area setting
is turned on.

Select Standard as the Printable Area setting to avoid banding in the
expanded margin area. See Selecting Paper Size and Orientation
Options for more information.

The paper thickness
lever is in the +
position.

Set the paper thickness lever to the 0 position and try printing again. See
Media Loading and Handling Guidelines for details.
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Vertical lines are misaligned or vertical banding appears
Possible cause

Solution

The print head nozzles
are clogged.

Clean the print head. See Cleaning the Print Head for instructions.

The printable side of
the paper is face
down.

Remove the paper and reload it with the printable side (whiter) face up.
See Media Loading and Handling Guidelines for instructions.

The paper thickness
lever is in the +
position.

Set the paper thickness lever to the 0 position and try printing again. See
Media Loading and Handling Guidelines for details.

The High Speed
setting is turned on.

Turn off the High Speed setting if vertical lines are misaligned. See
Customizing Print Quality and Special Effects for information.

The print head is
misaligned.

Run the Print Head Alignment utility. See Cleaning the Print Head for
instructions.

The printed image has incorrect or missing colors
Possible cause

Solution

The Ink option is set to
Black.

Change the Ink setting to Color. See Printing from Windows Applications
or Printing from a Macintosh for instructions.

The Media Type
setting doesn’t match
the loaded paper.

Make sure the Media Type setting matches the paper you’re using. See
Printing from Windows Applications or Printing from a Macintosh for
instructions.

The printable side of
the paper is face
down.

Remove the paper and reload it with the printable side (whiter) face up.
See Media Loading and Handling Guidelines for instructions.
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Possible cause

Solution

The Halftoning and
Color Adjustment
Mode options are set
incorrectly for your
document type.

Use the correct settings for the project you’re printing, following the
instructions in Customizing Print Quality and Special Effects and
Customizing Color Settings.

The ICM (Windows 95
and Windows 98),
sRGB (Windows 98),
or Color Sync
(Macintosh) settings
are incorrect for your
document.

Use the Automatic mode setting or different project type. See
Customizing Color Settings or Using ColorSync on the Macintosh for
more information.

The print head
nozzles are clogged.

Clean the print head. See Cleaning the Print Head for instructions.

The ink cartridges are
low on ink or one or
more ink colors are
empty.

Check the B black and A color ink out lights to see which cartridge you
may need to replace. See Replacing an Ink Cartridge for instructions.
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Possible cause

Solution

The colors displayed
on your monitor don’t
match the printed
colors.

Because your monitor and printer use different technologies to represent
colors, your printed colors cannot exactly match the colors you see on
your monitor screen. Use the ICM (Windows 95 and Windows 98 only),
sRGB (Windows 98), or ColorSync (Macintosh) setting to get as close a
match as possible. See Using Custom Project Types for more
information.

The color settings
in your application
software are incorrect.

You may be able to adjust various color settings in your application
software. See your software documentation for more information.

The printed image is faint or has gaps
Possible cause

Solution

The print head nozzles
are clogged.

Clean the print head. See Cleaning the Print Head for instructions.

The Media Type
setting doesn’t match
the loaded paper.

Make sure the Media Type setting matches the paper you’re using. See
Printing from Windows Applications or Printing from a Macintosh for
instructions.

The loaded paper is
damaged, old, or dirty.

Remove the paper and reload a new stack with the printable side face
up. See Media Loading and Handling Guidelines for instructions.

The ink cartridges are
low on ink.

Check the B black and A color ink out lights to see which cartridge you
may need to replace. See Replacing an Ink Cartridge for instructions.
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Color documents print in black and white
Possible cause

Solution

Your printer is not
selected in your
application.

Select your printer and port in your software application.

Color printing is not
selected.

Select color printing in your application and the printer software.

The printed image is blurry or smeared
Possible cause

Solution

The loaded paper is
damaged, old, or dirty.

Remove the paper and reload a new stack with the printable side face
up. See Media Loading and Handling Guidelines for instructions.

The printer’s thickness
lever is in the wrong
position.

Set the thickness lever to the 0 position for most papers. Set it to
the + position for thicker paper and envelopes. See Media Loading and
Handling Guidelines

The paper is damp or
the printable side is
face down.

Remove the paper and reload a new stack with the printable side face
up. See Media Loading and Handling Guidelines for instructions.

You loaded special
media without a
support sheet.

Follow the special media loading instructions in Media Loading and
Handling Guidelines and on the paper packaging for media that require
support sheets. Also try loading your media one sheet at a time.

You tried to print on
cardboard or other
non-recommended
media.

Make sure your paper or media meets the specifications listed in Paper.
If your printouts are still blurry after you change paper, clean the print
heads as described in Cleaning the Print Head.
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Possible cause

Solution

The Media Type
setting doesn’t match
the loaded paper.

Make sure the Media Type setting matches the paper you’re using. See
Printing from Windows Applications and Printing from a Macintosh for
instructions.

Ink has leaked inside
the printer.

Clean carefully inside the printer to remove spilled ink. See Cleaning the
Printer for instructions.

You’re using the High
Speed setting with a
misaligned print head.

Turn off High Speed (see Customizing Print Quality and Special Effects).
Then run the Print Head Alignment utility as described in Aligning the
Print Head.

The resolution of your If a photographic image looks grainy or rough, try using the
image may be too low. PhotoEnhance3 (PhotoEnhance on Windows 3.1) and Sharpness
settings to improve the printed quality. See Customizing Color Settings
for details. You can also increase the image resolution using your
image-editing software, or decrease the size of the image.
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Solving Printing Problems
If the printer won’t print, first check that:
◗ The printer is turned on and the P power light is on, but not flashing.
◗ Paper is loaded in the printer.
◗ The printer is plugged into a working electrical outlet that’s not
controlled by a switch or timer.
◗ The cable meets the specifications listed in Windows System
Requirements or Macintosh System Requirements.
◗ The interface cable is securely connected to the printer and computer
and both are turned on.
If you still can’t print, check the following solutions:

All lights are off
Possible cause

Solution

The printer is not
receiving power.

Try these solutions:
◗ Make sure the printer is turned on.
◗ Turn off the power and plug in the power cord securely.
◗ Make sure the outlet is not controlled by a switch or timer and is
operable.
◗ Try using another power outlet.
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The printer sounds as though it is printing, but nothing prints
Possible cause

Solution

The print head
nozzles are clogged
or the ink cartridges
are too old.

Clean the print head nozzles; see Cleaning the Print Head for
instructions. If cleaning doesn’t help, replace the cartridges. For
instructions, see Replacing an Ink Cartridge.

The S paper out light is flashing or on
Possible cause

Solution

If flashing, paper is
jammed.

See Paper jams inside the printer.

If on, there is no paper
in the sheet feeder or
the paper is loaded
incorrectly.

Load paper or remove the stack and reload it as described in the Printer
Basics book or Media Loading and Handling Guidelines. Then press the
E load/eject button to turn off the S paper out light and resume printing.

A B black or A color ink out light is flashing or on
Possible cause

Solution

If flashing, the ink
supply is getting low.

You need to replace the indicated ink cartridge soon. Make sure you
have a new cartridge, then see Replacing an Ink Cartridge for
instructions.

If on, the ink cartridge
is empty.

You must replace the indicated ink cartridge; see Replacing an Ink
Cartridge for instructions.
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Only the P power light is on, but nothing prints
Possible cause

Solution

The interface cable
is disconnected.

Turn off your printer and computer. Then connect the cable securely.
Make sure the cable meets the printer’s specifications, as described in
Windows System Requirements or Macintosh System Requirements.

The printer has an
internal problem.

Turn off the printer and computer, disconnect the interface cable, and run
a printer check as described in Running a Printer Check.

The printer software or
application software is
installed incorrectly.

If you ran a printer check successfully, make sure your printer and
application software are installed correctly. If you’re printing on a
network, you may need to set up your printer for network printing, as
described in Network Printing.

Your computer doesn’t
have enough memory
to handle the file
you’re printing.

Try the following:
◗ Close all other applications, including screen savers and virus
protections programs.
◗ Reduce the resolution of your image.
◗ Select fewer colors or a lower resolution for your monitor.
◗ Add more memory to your computer.

Printing is stalled.

In Windows, delete the stalled print jobs in Spool Manager:
◗ For Windows 95 and Windows 98, see Deleting a Print Job.
◗ For Windows 3.1, see Deleting a Print Job.
◗ For Windows NT 4.0, you need to uninstall the EPSON Printer Port.
Select Start, Programs, EPSON, then click EPSON Printer Port
Uninstall and follow the on-screen instructions.
On a Macintosh, delete stalled print jobs using Monitor3 (see Using
Monitor3) or open the Extensions folder, EPSON folder, and Spool
folder, and then delete any queued files.
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The P power and S paper out lights are flashing and the B black and A color ink out
lights are on
Possible cause

Solution

Jammed paper may be
blocking movement of
the print head.

Turn off the printer, wait a few seconds, and turn it back on to eject any
paper. If no paper is ejected, turn off the printer, remove the jammed
paper, and turn it on again. If the lights are still flashing and on, contact
EPSON as described in Where To Get Help.

All the lights are flashing
Possible cause

Solution

You haven’t removed
all the packing
material from the
printer.

Remove the packing material, following the instructions on the unpacking
sheet.

An internal error may
have occurred.

Turn off your printer, wait a few seconds, and turn it on again. If the lights
still flash or stay on, contact EPSON as described in Where To Get Help.

The printer has finished charging the ink cartridge, but the P power light is still
flashing
Possible cause

Solution

The ink cartridge
clamp isn’t locked.

Press down on the clamp to lock it into place.

Packing material
remains in the printer.

Remove the packing material, following the instructions on the
unpacking sheet.
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Page 167

color900.book Page 168 Wednesday, January 6, 1999 12:39 PM

Possible cause

Solution

The printer needs to
initialize.

If the printer is not moving or making noise, but the P power light is still
flashing after 5 minutes have passed, turn the printer off. If the light is
still flashing when you turn it back on, contact your EPSON dealer or see
Where To Get Help.

The printer may be
receiving data from the
computer.

Turn the printer and computer off. Disconnect the printer from the
computer. Turn the printer on. If the P power light continues to flash for
more than 5 minutes, contact your EPSON dealer or see Where To Get
Help.
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Solving Printer Software Problems
If you have trouble with your printer software, first check that your printer
is selected as the default Windows printer or as the current printer in the
Macintosh Chooser.
If you still have problems with your printer software, check the following
solutions. If you need to uninstall the printer software, see Uninstalling
Printer Software.

While installing your printer software, you see a New Hardware Found window
Possible cause

Solution

Windows has detected
your printer.

Click Cancel, and then click OK. Never select any other option on the
New Hardware Found window.

The printer software doesn’t work correctly after you upgrade your Windows
operating system
Possible cause

Solution

Your printer software is
not set up correctly for
the new operating
system.

Uninstall the printer software after installing Windows 95 or Windows 98,
as described in Uninstalling Printer Software. Then reinstall it as
described in the Start Here card.
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You see a spooling error message
Possible cause

Solution

Spooling error
messages or very
slow printing may be
caused by temporary
files (Windows 3.1
only).

Change the Spool Manager default spool directory, following the
instructions in Deleting a Print Job.

Your hard drive is full.

Delete unnecessary files to make room on the drive.

Your computer doesn’t
have enough memory
for the file you’re
printing.

Try the following:
◗ Close all other applications, including screen savers and virus
protections programs.
◗ Reduce the resolution of your image.
◗ Select fewer colors or a lower resolution for your monitor.
◗ Add more memory to your computer.

You see a memory error message (Macintosh)
Possible cause

Solution

You need to increase
the memory allocation
for your application,
EPSON Monitor3, or
both.

Choose Get Info from the File menu when the application is active or
EPSON Monitor3 is selected and increase the memory requirements.
See Using Monitor3 for more information.

Troubleshooting

If that doesn’t work, turn off background printing in the Chooser or in your
printer software; see Setting Up Background Printing Options for
instructions. You won’t be able to use Monitor3 after turning off
background printing.
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The Status Monitor 2 window doesn’t appear (Windows)
Possible cause

Solution

Status Monitor 2 is
not available in
Windows 3.1

Upgrade to Windows 95 or Windows 98.

You didn’t restart
your computer after
installing Status
Monitor 2.

Click Start, select Shut Down, click Restart the computer, and click
Yes to restart your computer. Then try using Status Monitor 2.

Bi-directional support
is not enabled.

Follow these steps to enable bi-directional support:
1 Make sure your printer is connected to your computer with a
bi-directional cable.
2 Then click Start, select Settings, and click Printers.
3 Right-click the EPSON Stylus COLOR 900 icon and select
Properties.
4 Click the Details tab, then click the Spool Settings button.
5 Click the Enable bi-directional support for this printer radio button
to turn on bi-directional support.
6 Click OK twice, then close the Printers window and try printing again.

You’re using
ScanDisk.

Troubleshooting

Before using ScanDisk, turn off background monitoring in Status
Monitor 2. (See Turning On Background Monitoring for instructions.)
Then turn it back on when you’re finished using ScanDisk.
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Printing is too slow
Possible cause

Solution

Your printer software
options are set
incorrectly.

For the fastest printing, try the following:
◗ Set Print Quality to Economy.
◗ Turn High Speed on.
◗ Choose Black ink and No Halftoning.
See Basic Printing and Advanced Printing for more information.

Your system doesn’t
have enough
resources.

◗ Clear space on your hard disk or run a defragmentation utility.
◗ Don’t run too many applications at the same time.
◗ Turn off virtual memory.
◗ Increase your system’s memory (RAM).

You’re using
background printing
on a Macintosh.

Choose Get Info from the File menu when the application is active or
EPSON Monitor3 is selected and increase the memory requirements.
See Using Monitor3 for more information.
If that doesn’t work, turn off background printing in the Chooser or in
your printer software; see Setting Up Background Printing Options for
instructions. You won’t be able to use Monitor3 after turning off
background printing.

You’re not using ECP
or Enhanced mode
and/or DMA transfers.

Troubleshooting

If your computer supports ECP or Enhanced mode and/or DMA
transfers, turn them on to speed up printing. See your computer
documentation for details.
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Your printer switches to the modem port or won’t confirm on the printer
port (Macintosh)
Possible cause

Solution

You’re using an
AppleTalk cable.

Make sure you’re using a standard LaserWriter II cable. See Macintosh
System Requirements for more information.

Your printer icon doesn’t appear in the Chooser (Macintosh)
Possible cause

Solution

Your Macintosh has
extension conflicts.

Disable Quick Draw ® GX in the Extensions Manager. Make sure EPSON
Monitor3 and SC 900 are enabled, and then restart your Macintosh.

Your application program can’t open your image file (Macintosh)
Possible cause

Solution

Not enough memory
is allocated to the
application.

Highlight the program icon and select Get Info from the File menu, then
increase the memory allocated to the application.

The “SC 900 cannot be used” message appears (Macintosh)
Possible cause

Solutions

The printer software
has been corrupted.

Remove and reinstall the printer software as described in Uninstalling
Printer Software. Then, in the Extensions Manager, disable Quick Draw
GX, enable EPSON Monitor3 and SC 900, and restart.
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After you install your printer software, you can’t run ScanDisk (Windows 95)
Possible cause

Solution

You cannot use
ScanDisk if Status
Monitor 2 is active.

Disable Status Monitor 2 whenever you want to run ScanDisk. See
Turning On Background Monitoring for details.

You cannot print on a Windows NT 4.0 network
Possible cause

Solution

Your printer is not set
up correctly as a
remote printer.

You may need to use a different network path and printer port. Select a
different port in the printer’s Properties windows and enter the new
network path to your printer at the DOS prompt. Then restart your
computer. See your Windows NT documentation for instructions on
changing the printer port and network path.
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Fixing Paper Problems
To avoid most paper handling problems:
◗ Use smooth, high-quality media designed for ink jet printers that meets
the media specifications in Paper.
◗ Follow all loading and handling instructions included with the media.
◗ When loading multiple sheets, fan the stack of paper to make sure the
sheets are not stuck together.
◗ Load the media with the printable side face up, as described in the
Printer Basics book or in Media Loading and Handling Guidelines.
If you have problems with paper handling, check the following tables for
solutions:

Paper doesn’t eject fully or is wrinkled
Possible cause

Solution

If the paper doesn’t
eject fully, you may
have set the wrong
paper size.

Press the E load/eject button to eject the paper. Then make sure you
select the correct paper size in your application or printer software. See
Selecting Paper Size and Orientation Options for instructions. See Paper
for the paper sizes you can print with.

If it’s wrinkled when it
comes out, the paper
may be damp or too
thin.

See the specifications in Paper for paper thicknesses you can print with,
as well as environmental requirements for storage.
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Paper doesn’t feed
Try this

Then do this

Remove the stack of
paper from the sheet
feeder.

Check that the paper:
◗ Isn’t curled or creased.
◗ Isn’t too old (see Media Loading and Handling Guidelines or your
paper packaging for more information).
◗ Isn’t loaded above the arrow on the left edge guide.
◗ Isn’t jammed inside the printer. (If the S paper out light is flashing,
paper is jammed.)
Then reload the paper as described in Media Loading and Handling
Guidelines, making sure the left edge guide is adjusted to fit the paper’s
width.

Paper jams inside the printer
Try this

Then do this

Turn off your printer,
open the cover, and
carefully remove all
the paper that’s inside,
including any small
pieces that may have
torn off. If possible,
remove the jammed
paper from the front of
the printer, rather than
from the sheet feeder.

Reload the paper as described in the Printer Basics book and Selecting
Special Media. If your paper jams frequently, make sure you:

Troubleshooting

◗ Use smooth, high-quality paper, loaded printable side up.
◗ Fan the stack and then even the edges before loading it.
◗ Don’t load paper above the arrow mark on the left edge guide.
◗ Place the paper against the right edge guide and adjust the left edge
guide to fit the width of your paper.
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Multiple pages feed at the same time
Try this

Then do this

Remove the stack of
paper from the printer.

◗ Make sure the paper isn’t too thin (see the specifications in Paper).
◗ Fan the edges of the stack of paper to separate the sheets.
◗ Reload the paper as described in the Printer Basics book and in
Media Loading and Handling Guidelines.
◗ Make sure the paper edge guides are snug against the edge of the
paper.
◗ If too many copies of a page or document are printing, check the
Copies settings in both the printer software and your application
program. See Selecting Paper Size and Orientation Options for more
information.
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Solving Miscellaneous Printout Problems
If your printout results are not what you expected, try these solutions.

Characters are incorrect or garbled
Possible cause

Solution

Your printer is not
selected in your
application or as the
Windows default
printer.

Select your printer in your application or select it as the default Windows
printer. See your Windows documentation or online help for instructions.

Your printer is not
selected in the
Macintosh Chooser.

Select your printer in the Chooser as described in the Start Here card.

Printing is stalled.

In Windows, delete the stalled print jobs in Spool Manager:
◗ For Windows 95 and Windows 98, see Deleting a Print Job.
◗ For Windows 3.1, see Deleting a Print Job.
◗ For Windows NT 4.0, you need to uninstall the EPSON Printer Port.
Select Start, Programs, EPSON, then click EPSON Printer Port
Uninstall and follow the on-screen instructions.
On a Macintosh, delete stalled print jobs using Monitor3 (see Using
Monitor3) or open the Extensions folder, EPSON folder, and Spool
folder, and then delete any queued files.

The interface cable
is not securely
connected.
Troubleshooting

Turn off your printer and computer. Then connect the cable securely.
Make sure the cable meets the printer’s specifications as described in
Windows System Requirements or Macintosh System Requirements.
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Possible cause

Solution

You’re using a switch
box with your printer.

Connect the printer directly to your computer and try printing again.

Your video driver may
be conflicting with the
EPSON printer driver.

Try using a standard VGA video driver (see your computer or video card
documentation for instructions on changing video drivers). If your printout
is correct, your video driver is interfering with the printer driver. Contact
your computer or video card manufacturer to see if an updated driver is
available.

The margins are incorrect
Possible cause

Solution

Margins are set
incorrectly in your
software application.

Check your software documentation for instructions on selecting the
correct margins for your paper size. Make sure the margins are within the
printable area of the page. See Printable area for more information.

Paper settings in the
printer software are
incorrect for your
paper size.

Select the correct paper settings for your paper size. Make sure the
Printable Area setting is correct for your project. See Selecting Paper
Size and Orientation Options and Printing on Special Media for more
information.

The image size or position is incorrect
Possible cause

Solution

The paper and/or
layout options are set
incorrectly.

Check the paper settings and the settings in the Layout dialog box (not
available for Windows 3.1). See Selecting Paper Size and Orientation
Options for instructions. Also check the paper and layout settings in
your application software.
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The image is inverted, as if viewed in a mirror
Possible cause

Solution

You used a Flip
Horizontal option.

Turn off the Flip Horizontal or mirror setting in your application software
or the printer software. See Customizing Print Quality and Special
Effects for information.

A portion of your image doesn’t print (Macintosh)
Possible cause

Solution

Your system doesn’t
have enough available
memory.

Close any other applications you are running and turn off background
printing as described in Setting Up Background Printing Options.

You need to increase
the memory allocation
for your application,
EPSON Monitor3, or
both.

Choose Get Info from the File menu when the application is active or
EPSON Monitor3 is selected and increase the memory requirements.
See Using Monitor3 for more information.

Troubleshooting

If that doesn’t work, turn off background printing in the Chooser or in
your printer software; see Setting Up Background Printing Options for
instructions.You won’t be able to use Monitor3.
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The printer prints blank pages
Possible cause

Solution

Your printer is not
selected in your
application, or as the
Windows default
printer, or in the
Macintosh Chooser.

In Windows, select your printer as the default Windows printer. See your
Windows documentation or Windows online help for instructions.

Paper settings in the
printer software are
incorrect for your
paper size.

Select the correct paper settings for your paper size. Make sure the
Printable Area setting is correct for your project. See Selecting Paper
Size and Orientation Options and Printing on Special Media for more
information.

The print head
nozzles are clogged.

Clean the print head following the instructions in Cleaning the Print
Head.

Troubleshooting

In Macintosh, select your printer in the Macintosh Chooser; see your
Start Here card for instructions.

Page 181

color900.book Page 182 Wednesday, January 6, 1999 12:39 PM

Uninstalling Printer Software
If you need to uninstall and reinstall your printer software, follow the steps
in this section for your operating system:
◗ Windows 95, Windows 98, and Windows NT 4.0 Instructions
◗ Windows 3.1 Instructions
◗ Macintosh Instructions

Windows 95, Windows 98, and Windows NT 4.0
Instructions
If you uninstall and
then reinstall the
printer software in
Windows 95, 98, or
NT 4.0, you must also
uninstall and then
reinstall Status
Monitor 2 so it can
recognize your printer.
If you’re using
Windows 98 with a
USB connection, you
must also uninstall and
then reinstall the
EPSON USB printer
Device software.

Troubleshooting

1 Double-click the My Computer icon, then double-click the Control
Panel icon.
2 Double-click Add/Remove Programs.
3 To uninstall the printer software, select EPSON Printer Software in
the program list.
4 Click the Add/Remove button and then follow the instructions on the
screen.
5 If Status Monitor 2 is installed you need to uninstall it also. First,
right-click the
icon in the bottom-right corner of the taskbar and
select Stop monitoring now to turn off background monitoring. Then
follow steps 1 through 4 again, selecting EPSON Status Monitor 2 in
the program list to uninstall it.
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6 If you’re using Windows 98 with a USB connection, you need to
uninstall the EPSON USB Printers Device Software also. Follow
steps 1 through 4 again, selecting EPSON USB Printer Device in the
list.
7 Restart your computer.
8 To reinstall your software, see the Start Here card.

Windows 3.1 Instructions
1 Double-click the Main program group icon, then double-click the
Control Panel icon.
2 Double-click Printers.
3 Select EPSON Stylus COLOR 900 in the Installed Printers list and
click the Remove button.
4 To reinstall your software, see the Start Here card.
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Macintosh Instructions
1 Insert your printer software CD-ROM.
2 Double-click the

EPSON Printer Driver Installer icon.

3 At the printer driver installation screen, click Continue.
4 Click the arrow in the list showing Easy Install, and select Remove.

changes to
Remove

5 Click the Remove button at the bottom of the screen.
6 After the software is uninstalled, click Quit on the Installer window,
then restart your Macintosh.
7 To reinstall your software, see the Start Here card.
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Where To Get Help
EPSON provides technical assistance through electronic support services
and automated telephone services 24 hours a day. The following tables
list the contact information:

Electronic support services
Service

Access

World Wide Web

From the Internet, you can reach EPSON’s Home Page at
http://www.epson.com.

EPSON Internet FTP Site

If you have Internet FTP capability, use your Web browser (or other
software for FTP downloading) to log onto ftp.epson.com with the
user name anonymous and your e-mail address as the password.

EPSON Download Service

You can call the EPSON Download Service at (800) 442-2007. Set
your communications software to 8 data bits, 1 stop bit, no parity.
Modem speed can be up to 28.8 Kbps.

EPSON Forum on
CompuServe®

Members of CompuServe can type GO EPSON at the menu prompt
to reach the Epson America Forum. For a free introductory
CompuServe membership, call (800) 848-8199 and ask for
representative #529.
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Automated telephone services
Service

Access

EPSON SoundAdviceSM

For pre-recorded answers to commonly asked questions about
EPSON products 24 hours a day, seven days a week, call
(800) 922-8911.

EPSON FaxAdviceTM

Access EPSON’s technical information library by calling
(800) 922-8911. You must provide a return fax number to use this
service.

EPSON Referral Service

For the location of your nearest Authorized EPSON Reseller or
Customer Care Center, call (800) 922-8911.
To speak to a technical support representative, dial (310) 787-6346 (U.S.)
or (905) 709-2567 (Canada), 6 AM to 8 PM, Pacific Time, Monday through
Friday and 7 AM to 4 PM, Saturday. Toll or long distance charges may
apply.
Before you call, please have the following information ready:

If you need help
using another
manufacturer’s
software with an
EPSON product, see
the documentation
for that software for
technical support
information.

Troubleshooting

◗ Product name
◗ Product serial number (located on the back of the printer)
◗ Computer configuration
◗ Description of the problem
You can purchase ink cartridges, paper, and manuals from EPSON
Accessories at (800) 873-7766 (U.S. sales only). Or visit our website at
www.epsonsupplies.com (U.S. sales only). In Canada, please call
(800) 873-7766 for dealer referral.
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Specifications
Printing
Printing method

On-demand ink jet

Nozzle configuration

192 black nozzles
288 color nozzles (96 cyan, 96 magenta, 96 yellow)

Resolution

Maximum 1440 × 720 dpi

Input buffer

256KB

Print direction

Bidirectional with logic seeking

Control code

ESC/P 2™ and raster graphics code, EPSON Remote, and IBM® X24E
emulation code

Character tables

1 italic and 12 graphics character tables

Character sets

14 international character sets and 1 legal character set

Specifications
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Paper
Paper type

Size

Paper types

Single sheets

Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
A5 (148 × 210 mm)
B5 (182 × 257 mm)
Legal (8.5 × 14 inches)
Half letter (5.5 × 8.5 inches)
Executive (7.5 × 10 inches)

Plain paper and
0.003 to 0.004 inch 17 to 24 lb
special ink jet
(0.08 to 0.11 mm) (64 to 90 g/m2)
papers distributed
by EPSON

Transparencies
and glossy film

Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
A6 (105 × 148 mm, glossy
film only)

Transparencies
and glossy film
distributed by
EPSON

—

—

Photo Paper

4 × 6 inches
(102 × 152 mm)
Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
Panoramic (8.27 × 23.4
inches, 210 × 584 mm)

Photo Paper
distributed by
EPSON

—

—

Photo stickers

A6 (105 × 148 mm) with
16 frames

Photo stickers
distributed by
EPSON

—

—

Specifications

Thickness

Weight
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Paper type

Size

Self adhesive
A4 (210 × 297 mm)
sheets and
Letter (8.5 × 11 inches;
iron-on cool peel
iron-on cool peel
transfer paper
transfer paper only)

Paper types

Thickness

Weight

Self adhesive
sheets and
iron-on cool peel
transfer paper
distributed by
EPSON

—

—

Envelopes

#10

9.5 × 4.1 inches
(240 × 104 mm)
DL 8.7 × 4.3 inches
(220 × 110 mm)
C6 4.4 × 6.4 inches
(114 × 162 mm)
Note card envelope
5.2 × 8.7 inches
(132 × 220 mm)

Plain, bond, or
air mail paper

0.006 to 0.02 inch
(0.16 to 0.52 mm)

12 to 20 lb
(45 to 75 g/m2)

Cards

A6 (105 × 148 mm)
8 × 10 inches
(203 × 254 mm; ink jet
cards only)

Ink jet cards and
note cards
distributed by
EPSON

—

—

Specifications
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Print only under these conditions:
Temperature: 59 to 77 °F (15 to 25 °C)
Humidity: 40 to 60% RH
Store glossy film and self adhesive sheets under these conditions:
Temperature: 59 to 86 °F (15 to 30 °C)
Humidity: 20 to 60% RH
Since the quality of any particular brand or type of paper may be
changed by the manufacturer at any time, EPSON cannot guarantee
the use of any particular brand or type of paper. Always test samples
of paper stock before purchasing large quantities or printing
large jobs.
Poor quality paper may reduce print quality and cause paper jams and
other problems. If you encounter problems, switch to a higher grade of
paper. Do not load curled or folded paper, envelopes, or
transparencies.

Specifications
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Printable area
A
A
BR

BL

BR
C1

BL
C1

C2

Envelopes

Single sheets and cards

Always load paper
into the sheet feeder
short edge first
except envelopes.
Load envelopes long
edge first.

Specifications

A

The minimum top margin is 0.12 inch (3.0 mm).
When printing multiple sheets of EPSON Photo Quality Glossy Film, the
minimum top margin is 1.2 inches (30 mm).

BL

The minimum left margin is 0.12 inch (3.0 mm).

BR

The minimum right margin is:
0.35 inch (9.0 mm) for letter and legal
1.10 inches (28 mm) for #10 envelopes
0.28 inch (7 mm) for DL envelopes
0.12 inch (3.0 mm) for all other paper sizes and C6 envelopes.

C1

The minimum bottom margin is 0.55 inch (14.0 mm) using the Standard
printable area setting.

C2

The minimum bottom margin can be decreased to 0.12 inch (3.0 mm)
using the Maximum printable area setting. However, the print quality in
the expanded printable area may be reduced.
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Ink Cartridges
Specification Black ink cartridge (T003011)

Color ink cartridge (T005011)

Color(s)

Black

Cyan, magenta, and yellow

Print
capacity*

1200 pages (A4, ISO/IEC 10561 letter
pattern); 840 pages at 5% coverage at
360 dpi)

570 pages (A4, 5% coverage at
360 dpi)

Cartridge life

2 years from production date and up to within 6 months after opening package at
77 °C (25 °F)

Storage
temperature

–4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Transit
temperature

–22 to 140 °C (–30 to 60 °F)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Freezing
3.2 °F (–16 °C)
temperature**
Dimensions

1.1 (W) × 2.6 (D) × 1.6 (H) inches
28.9 (W) × 67.4 (D) × 41.8 (H) mm

–0.4 °F (–18 °C)
2.1 (W) × 2.7(D) × 1.6 (H) inches
54.0 (W) × 67.4 (D) × 41.8 (H) mm

* The print capacity may vary depending on how often you clean the print head and use the printer.
** The ink thaws and is usable after approximately 3 hours at 77 °F (25 °C).

To ensure good results, use genuine EPSON cartridges and do not
refill them. Other products may cause damage to your printer not
covered by EPSON’s warranty.
Do not use an ink cartridge after the expiration date on the package.
Specifications
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Mechanical
Paper feed method

Friction with auto sheet feeder, rear entry

Sheet feeder
capacity

Maximum 100 sheets of 17 lb (64 g/m2) paper

Dimensions
Storage

Width: 18.4 inches (467 mm)
Depth: 11.7 inches (269 mm)
Height: 7.8 inches (199 mm)

Printing

Width: 18.4 inches (467 mm)
Depth: 23.4 inches (594 mm)
Height: 12.8 inches (325 mm)

Weight

18.5 lb (8.4 kg) without the ink cartridges

Electrical
Specification

120 V model

240 V model*

Input voltage range

99 V to 132 V

198 V to 264 V

Rated frequency range

50 to 60 Hz

Input frequency range

49.5 to 60.5 Hz

Rated current

0.7 A

Power consumption

Approx. 30 W (ISO 10561 Letter Pattern)

0.4 A

* Also designed for IT power systems with Phase to Phase voltage 220–240 V

Specifications
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Environmental
Temperature

Operation
Storage*
Transit*

Humidity

Operation
Storage*

50 to 95 °F (10 to 35 °C)
–4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)
–4 to 140 °F (–20 to 60 °C)
120 hours at 140 °F (60 °C)
20 to 80% RH
5 to 85% RH (without condensation)

* Stored in shipping container

Safety Approvals
Safety standards

UL 1950 with D3, CSA 22.2 No. 950

EMC

FCC part 15 subpart B class B

Specifications
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Interfaces
Parallel interface

Forward channel
Specification

Description

Data format

8-bit parallel, IEEE-1284 compatibility mode

Synchronization

STROBE pulse

Handshake timing

BUSY and ACKNLG signals

Signal level

TTL compatible

Connector

57-30360 Amphenol connector or equivalent

Reverse channel

Specifications

Specification

Description

Transmission mode

IEEE-1284 Nibble mode

Adaptable connector

57-30360 Amphenol connector or equivalent

Synchronization

Refer to the IEEE-1284 specification

Handshaking

Refer to the IEEE-1284 specification

Signal level

IEEE-1284 Level 1 device

Data transmission
timing

Refer to the IEEE-1284 specification
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Serial interface

USB interface

Specifications

Specification

Description

Standard

Based on RS-423

Synchronization

Synchronous

Bit rate

Approximately 1.8 Mbps

Handshaking

X-ON/X-OFF and DTR protocol

Word format

Data bit: 8 bits
Parity bit: None
Start bit: 1 bit
Stop bit: 1 bit

Connector

8-pin mini-DIN

Recommended
cable

ImageWriter II cable (preferably Belkin brand)

Specification

Description

Standard

Based on Universal Serial Bus Specifications
Revision 1.0, Universal Serial Bus Device Class
Definition for Printing Devices Version 1.0

Bit rate

12 Mbps (full speed device)

Data encoding

NRZI

Adaptable
connector

USB Series B

Recommended
cable length

6.5 feet (2.0 meters)
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Index
A
Accessories, 77 to 78, 129, 138, 186
Advanced mode, selecting, 31 to 32,
34 to 35
Advanced settings
color, 37 to 44
layout, 55 to 70
orientation, 44 to 47, 51 to 52
paper size, 44 to 53
print quality, 34 to 37
project types, 31 to 33
saving custom, 73 to 75
special effects, 34 to 37
Aligning print head, 145 to 147, 158 to 159
Automatic mode, 20, 28

B
Background printing
Macintosh, 28, 112 to 115, 120 to 121
Windows, 94 to 111
Banding, 158 to 159
Basic printing, 17 to 29, 120 to 121
Bitmap files, 60 to 62
Blank pages, 181

Blurry printouts, 162 to 163
Brightness setting, 41

C
Cable, printer, 10, 11
Canceling print jobs
Macintosh, 29, 114
Windows, 24 to 25
Cards, see Photo Quality Ink Jet Cards
Character sets, international, 187
Character tables, 187
Characters, garbled, 178 to 179
Cleaning
print heads, 134 to 136
printer, 148
sheets, 79, 148
Coax interface board, 129 to 132
Collate setting, 46, 54
Color Adjustment modes, 40
Color problems, 159 to 162
Color settings, customizing, 37 to 44
ColorSync, using, 33, 42 to 44
CompuServe, 185

Page 197

color900.book Page 198 Wednesday, January 6, 1999 12:39 PM

Configuration options, Macintosh,
118 to 119
Contrast setting, 41
Control code, 187
Control panel, 135 to 136, 153 to 154,
164 to 168
Custom settings
color, 37 to 44
deleting, 75
layout, 55 to 70
orientation, 44 to 47, 51 to 52
paper size, 44 to 53
print quality, 34 to 37
project types, 31 to 33
redefining, 74 to 75
saving, 73 to 75
special effects, 34 to 37
Cyan setting, 41

D
Data transfer, optimizing, 106
Default printer options, setting, 21 to 23
Deleting print jobs
Macintosh, 29, 114
troubleshooting, 166, 178
Windows 3.1, 110
Windows 95 and 98, 94, 104
Windows NT, 166
Despooler, 109
Index

Diagnosing problems, 152 to 157
Diffusion, error, 36
Digital Camera setting, 32, 38 to 39
Dithering, 36
DMA transfers, 108, 172
Documentation, how to use, 12 to 13
DOS, 17, 146

E
Economy setting, 32, 35, 157
ECP mode, 172
Electrical specifications, 193
ENERGY STAR, 14
Enhanced mode, 172
Envelopes
printing on, 81
specifications, 189 to 191
Environmental specifications, 194
EPSON
Accessories, 129, 138, 186
help, 185 to 186
media, 77 to 78
Monitor3, 29
printer port, 107 to 108
Remote control code, 187
Spool Manager, see Spool Manager
Error Diffusion setting, 36
Error message, spooling, 170
Error notification, 100 to 103, 118 to 119
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ESC/P 2 control code, 187
Ethernet board, 129 to 132

F
Faint printouts, 161 to 163
Film, see Photo Quality Glossy Film
Fine Dithering setting, 36
Finest Detail setting, 36
Fit to Page setting, 58, 64 to 65
Flip Horizontal setting, 36, 87, 180
Forms, loading, 81

G
Garbled characters, 178 to 179
Graph setting, 32, 39

H
Halftoning setting, 36
Head Cleaning utility, 134 to 135
Help, EPSON, 185 to 186
Help, online, 152
High Speed copies, 108, 118 to 119
High Speed setting, 36, 157
Horizontal banding, 158

Index

I
IBM X24E emulation code, 187
ICM (Image Color Matching) setting, 32,
42, 161
Ink
cartridge, transporting, 149
level, 116, 153, 165
monitoring level, 103, 116 to 117
replacing cartridge, 138 to 141, 157
replacing outdated cartridge, 138,
142 to 144
setting, 20, 27, 32, 35
specifications, 192
Ink Jet Paper
choosing, 20, 27, 77 to 78
specifications, 188 to 191
Ink Jet Transparencies, see
Transparencies
Ink setting, 159
Installing interface boards, 131 to 132
Interface (I/F) mode setting, 132
Interface boards, 129 to 132
Interface specifications, 195 to 196
International character sets, 187
Iron-On Cool Peel Transfer Paper
choosing, 77
printing on, 87
specifications, 189 to 191
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J

M

Jammed paper, 154, 176
Job Status window, 103 to 106

Macintosh
background printing, 28, 120 to 121
checking ink level, 116
ColorSync, 42 to 44
configuration options, 118 to 119
increasing memory allocation, 113
interface boards, 129 to 132
managing print jobs, 113 to 115,
118 to 119
Monitor3, 112 to 115
previewing, 28, 71 to 72
printing from, 26 to 29, 120 to 121
problems printing, 173
Status Monitor, 116 to 117
system requirements, 11
uninstalling printer software, 184
Magenta setting, 41
Main tab, 20
Maintaining printer, 133 to 148
Manuals, how to use, 12 to 13
Margins
incorrect, 179
with multiple sheets, 85, 86
Maximum printable area setting, 86
Mechanical specifications, 193
Media Type setting, 20, 27, 32, 35,
77 to 78, 83
Media, ordering, 77 to 78

L
Landscape setting, 47, 52
Layout
icon, 28, 54, 64
options, setting, 55 to 70
problems, 179
tab, 21, 58
Letterhead, printing on, 81
Lever, thickness, 80, 81, 85
Lights, 153 to 154, 164 to 168
LocalTalk board, 129 to 132

Index
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Memory allocation, increasing on
Macintosh, 113
MicroWeave setting, 36
Mirror images, 36, 87, 180
Monitor3, 112 to 115
Monitoring
ink level, 103, 116 to 117, 153
preferences, Macintosh, 118 to 119
preferences, Windows, 96 to 105
print jobs, see Background monitoring
More Settings dialog box, 34 to 42
Moving printer, 149
Multiple print layouts, 59 to 60, 69 to 70

N
Network printing
Macintosh, 128
Windows 95, 98, 122 to 123
Windows NT 4.0, 125 to 127
Nozzle Check, 137 to 145, 155

O
Optimizing data transfer, 106
Options, interface boards, 129 to 132
Ordering
interface boards, 129
media, 77 to 78

Index

Orientation options, 44 to 47, 51 to 52
Outdated ink cartridge, 138, 142 to 144,
157

P
Packing printer, 149
Page frames, 59 to 60, 69 to 70
Page layouts, multiple, 69 to 70
Page Order options, 60, 70
Page Setup dialog box, 26, 51
Panoramic Photo Paper, see Photo Paper
Paper
glossy, see Photo Quality Glossy Film
handling problems, 175 to 177
jams, 154, 176
ordering, 77 to 78
photo, see Photo Paper
plain, 20, 27
specifications, 188 to 191
support extension, 81, 82
thickness lever, 80, 81, 85
Paper Size options, 44 to 53
Paper support sheet, 84, 85, 86
Paper tab, 20, 45
Parallel interface boards, 129 to 132
Parallel interface specifications, 195
Parts of printer, 151
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Pausing print jobs
Macintosh, 29
Windows, 24 to 25
PC interface boards, 129 to 132
Photo Paper
choosing, 20, 27, 77
printing on, 82 to 84
specifications, 188 to 191
Photo Quality Glossy Film
choosing, 20, 27
printing on, 86
specifications, 188 to 191
Photo Quality Ink Jet Cards
choosing, 77
printing on, 85
specifications, 189 to 191
Photo Quality Ink Jet Paper
choosing, 20, 27, 77
specifications, 188 to 191
Photo Quality Self Adhesive Sheets
choosing, 77
printing on, 85
specifications, 189 to 191
Photo Stickers
choosing, 78
printing on, 87
specifications, 188
PhotoEnhance setting, 32, 37 to 39
PICT files, 66 to 67
Plain paper, 20, 27, 188 to 191
Index

Portrait setting, 47, 52
Preprinted forms, loading, 81
Previewing, Macintosh, 28, 71 to 72
Print dialog box, 18
Print head
aligning, 158 to 159
cleaning, 134 to 136
Print jobs
managing in Windows, 89 to 111
managing on Macintosh, 112 to 115,
118 to 119
Print layouts, multiple, 59 to 60, 69 to 70
Print Order options, 54
Print quality
customizing, 34 to 37
problems, 157 to 163
Print time, setting, 115, 120 to 121
Printable area
setting, 47, 52, 84, 179, 181
specifications, 84, 191
Printer
cable, 10, 11
check, 155 to 156
cleaning, 148
ID, 156 to 157
moving, 149
parts, 151
port, EPSON, 107 to 108
transporting, 149
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Printer software
problems, 169 to 173
settings, see Settings, printer software
uninstalling, 182 to 184
Problems
color, 159 to 162
diagnosing, 152 to 157
paper handling, 175 to 177
print quality, 157 to 163
printer software, 169 to 173
printing, 164 to 168
slow printing, 172
solving, 150 to 181
Status Monitor 2, 171
unexpected printout results, 178 to 181
Progress Meter
dialog box, 24, 90
Speed & Progress options, 91 to 92
Project types, custom, 31 to 33

Q
Quality/Speed slider, 20, 28

R

Resolution, see Print quality
Reverse Order setting, 47, 54
Rotate by 180° setting, 47, 52

S
Safety approvals, 194
Safety instructions, 14 to 16
Saturation setting, 41
ScanDisk, 174
Self Adhesive Sheets, see Photo Quality
Self Adhesive Sheets
Self test, 155 to 156
Serial interface boards, 129 to 132
Serial interface specifications, 196
Service, 185 to 186
Settings, printer software
advanced, see Advanced settings
basic, 18 to 21, 26 to 29, 120 to 121
default, 21 to 23
reusing on Macintosh, 26
Sharpness setting, 39
Slow printing, 172
Smears, 80, 81, 85, 162 to 163
Special effects, 34 to 37

ReadMe files, 152
Reduce/Enlarge setting, 46, 56 to 59
Rendering Intent setting, 44
Replacing ink cartridge, 138 to 141
Index
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Specifications
character tables, 187
electrical, 193
environmental, 194
ink cartridges, 192
interface, 195 to 196
mechanical, 193
paper, 188 to 191
printing, 187
safety approvals, 194
Speed & Progress options, 90, 91 to 92
Spool directory, changing default, 111
Spool folders, 107, 118 to 119
Spool Manager
problems, 166, 170, 178
using with Windows 3.1, 109 to 111
using with Windows 95 and 98,
93 to 94
sRGB (Standard Red Green Blue) setting,
33, 42
Stalled print jobs, deleting, 94, 106, 110
Status Alert dialog box, 97 to 105
Status Monitor
Macintosh, 116 to 117
problems, 171
uninstalling, 182
Windows, 24, 94 to 106
Support sheet, 84, 85, 86
Support, technical, 185 to 186
System requirements, 10 to 11
Index

T
Technical specifications, 187 to 196
Technical support, 185 to 186
Testing printer, 155 to 156
Text/Graph setting, 32, 39
Thickness lever, 80, 81, 85
Tone setting, 39
Transparencies
choosing, 20, 27, 78
printing on, 85
specifications, 188 to 191
Transporting printer, 149
Troubleshooting, 150 to 181
Twinax interface board, 129 to 132

U
Uninstalling interface board, 132
Uninstalling printer software
Macintosh, 184
Windows, 182 to 183
USB
interface specifications, 196
Macintosh, 11
Windows, 10
User Defined paper size, 48 to 50, 53
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Utility
dialog box, 91, 106, 116
icon, 134, 136, 145
Monitor3, 113
print head alignment, DOS, 146
print head alignment, Windows and
Macintosh, 145
Status Monitor 2, 171
tab, 134, 136, 145

Y
Year 2000, 14
Yellow setting, 41

V
Vertical banding, 159

W
Watermarks, 60 to 63, 66 to 69
Windows
default options, setting, 21 to 23
managing print jobs, 24 to 25,
89 to 111
printer status, checking, 24 to 25, 90
printing from, 17 to 23
Status Monitor 2, 24, 94 to 106
system requirements, 10
uninstalling printer software,
182 to 183
World Wide Web, 185

Index
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